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Subject to modifications.
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Änderungen vorbehalten.
Alle Angaben beschreiben unsere Produkte in allgemeiner
Form. Sie stellen keine Beschaffenheits- oder Haltbarkeits­
garantie dar.

Sous réserve de modifications.
Les caractéristiques indiquées ne décrivent nos produits
que sous une forme générale. Elles n'impliquent aucune
garantie de qualité ou de durabilité.
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1 Introduction

The HBM MC1609 devices are intended to provide a cost
effective, plug and play expansion capability to enhance
the HBM Somat eDAQ Data Acquisition unit. It is periph­
eral and therefore a feasible solution for use with other
compliant hardware such as QuantumX, MGC Series
etc. complying with the CAN Open Standard.

The device is intended for ‘remote’ installation and so will
be capable of being fixed to a carrying structure with rela­
tive ease and will comply with thermal implications that
may be inferred by its positioning. Pass through will
enable multiple devices to be ‘daisy chained’ to achieve
larger channel compositions.

Features (MC1609)

� 16 inputs in one compact package for thermocouples

- Type K (NiCr-Ni): -100.0 °C to +1372.0 °C

- Type J (Fe-CuNi): -100.0 °C to +1200.0 °C

- Type T (Cu-CuNi): -100.0 °C to +400.0 °C

� Excellent precision (low pass/digital filtering, lineariza­
tion, temperature compensation, …)

� Internal sampling rate 1000 Hz per channel

� Measuring rate 0.5 Hz to 200 Hz for all channels
(user­configurable)

� Detection of missing or broken thermocouple sensor

� Over­voltage protection ±60 V (permanent) on sensor
inputs

� Calibration traceable to national standard included

� Channel indicator LED's
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� High­speed CAN interface (default 500 kBits/s, up to
1 MBits/s)

� Configuration of all CAN parameter (Standard CAN,
sample point, identifier, …)

� In­system configuration with modern SomatCR Assis­
tant software

� Two identical CAN system LEMO connectors (parallel
connected) for easy installation of CAN bus and sup­
ply

� Power supply range ca. +8 V …+42 V, ideal for all
standard board power systems 12 / 24 / 42 V

� Low power consumption (typically 2 W)

� 500 V isolation voltage between channel, CAN inter­
face and power supply

� Rugged and compact housing

� Easy­to­use, refer to chapter 4 “First Steps“ for more
information

Operation environment

� Operation temperature: ­40 °C to +120 °C

� Device protection class: IP65
Pollution Degree 3 (according to IEC 60664­1)

� For operation in the engine compartment

Configuration

� Comfortable configuration via CAN

� Easy­to­use Windows application, featuring
auto­detection and auto­configuration

� CANdb compatible signal data base for all connected
devices
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2 Important Information

2.1 Symbols

Notice

Observe all instructions given at this sign to avoid injury,
danger or damages!

WARNING

Observe all instructions given at this sign to avoid injury,
danger or damages!

Important

Understand all the information given near this sign in
order to benefit from all advantages of the system.

2.2 Liability

We reserve the right to make technical alterations to the
hardware, software, and documents at any time without
prior notification.

HBM does not assume liability for damages of any kind
that are caused directly or indirectly by the use of devices
or accompanying software, or by errors or omissions in
the documentation.
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Hardware, software and documentation are provided in
an "as is" condition and without any guarantees regard­
ing their function in the end­customer's systems.

CAUTION

Protection may be impaired if the device is not used as
specified.

CAUTION

Always use HBM certified parts like cables, mounting
kits, etc.

2.3 CAN Warning

It is recommended to connect data acquisition devices
like MC1609 to a separate CAN bus (measurement bus).
This ensures maximum performance for measurement
and minimizes the risks of disturbing an existing CAN
bus system.

Be careful when connecting third­party devices to a mea­
surement bus with HBM MC1609 devices. Make sure to
use compatible configuration settings for all devices
(same CAN bit rate, different CAN identifiers etc.)
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WARNING

Usage of MC1609 devices may be dangerous!
For trained personnel only!

Connecting a MC1609 device to an existing CAN bus
system (e.g. vehicle or automation system) may affect
the behavior of the CAN bus. This may lead to severe
personal injury or material damage. The usage of
MC1609 devices is allowed only for individuals under­
standing the functionality and handling.

To avoid any risks, observe the following guidelines:

� Read and understand this manual.

� Use proper configurations (especially CAN parame­
ters).

� When connecting to your CAN bus system, observe
all relevant security precautions.

HBM assumes NO LIABILITY for errors, damage, or
injury caused by any use or unauthorized, improper
or incorrect handling of MC1609 devices.

If you have any questions, contact HBM immediately,
BEFORE using MC1609 devices. See chapter 2.9 for
contact information.

2.4 EMC information

HBM declares that the product described in this manual
is in conformity with the requirements of the European
EMC Directive 2004/108/EG, if used in combination with
cables up to 3m length. We do not recommend the use
of the MC1609 in combination with cables exceeding 3m
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length. This will cause the unit to exceed the electromag­
netic immunity specifications. Since the unit is designed
for 'localized' installation this can easily be avoided during
the installation. Please contact your local support for
additional information.

Notice

HBM MC1609 devices are Class A products. In a dome­
stic environment, these products may cause radio interfe­
rence. In this case the user may be required to take ade­
quate measures.

2.5 Handling / Mounting Precautions

MC1609 devices are equipped with a GORE� mem­
brane which is essential to enable regulation of pressure
and humidity. This is required to cope with the rapidly
changing environmental temperatures in cars.

This is a suitable and commonly used method.

It is necessary that the small vent in the device case is
open and freely. If this is not obeyed, condensation may
dam up in the case and lead to permanent damage of the
device !

Water standing at the vent damages the membrane! If
the device will be installed where water or other liquids
could collect, install the device so that the small vent in
the device case is open and free and that liquids can
drain away. Standing liquids on the vent can permanently
damage the membrane. The device then loses the fea­
tures defined by IP65
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CAUTION

Do not cover this hole. Free air circulation required!

CAUTION

Do not insert objects into the hole, this would destroy the
membrane.

CAUTION

Do not unscrew any screws on the front side. This could
affect IP6x­protection of the device.

CAUTION

Make sure that the devices are safely mounted to avoid
damages.
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CAUTION

Do not mount with the connectors on the bottom. The
connectors should be on one side or the top of the
device.

CAUTION

The mounting position should allow easy access to the
connectors to disconnect the power/CAN cable easily.

CAUTION

When operated in hot environments (e.g. engine com­
partment) the device surface may be hot, too. Cool down
before handling or use approporate protection.

2.6 Safety

All MC1609 devices have been designed to conform to
the relevant safety standards. They are manufactured
under the supervision of an ISO9000 Quality Manage­
ment System.

CAUTION

Do not open the device. No serviceable parts inside.
Do not make any mechanical or electrical changes.
Don't even loosen the screws on the front side.
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IP6x protection may be destroyed by unauthorized
manipulation of the device!

Notice

Before connecting any cable, make sure that the applied
signals (power supply, thermocouples) are within the
allowed range (refer to chapter 10 “Technical Data”).

Notice

Electrical potential difference in the vehicle over the
shield of the interface cables of modules may occur!
Mount the devices only to components with the same
electrical potential or insulate the devices from the com­
ponents.

CAUTION

To prevent fire, use a safety fuse in the power supply.
The fuse must open after a maximum of 120 seconds at
4.76 amperes.

Notice

Make sure that the device is installed correctly. Operation
of device only within the specified environment (refer to
chapter 10 “Technical Data”).
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All input channels are galvanically isolated against each
other as well as against supply voltage and CAN. This
functional isolation is designed for 500 VDC. A type
approval with a test voltage of 500 VDC was performed
successfully.

Important

The above mentioned galvanic isolation of 500 VDC is a
functional insulation which is not tested in routine test.
Therefore, HBM MC1609 devices may only be used for
measurements with voltages up to max. 60 VDC.

HBM assumes NO LIABILITY for use with voltages
greater than 60 VDC.

2.7 Maintenance & Calibration

All MC1609 devices are delivered with a calibration cer­
tificate issued by a traceable National Calibration Labora­
tory.

Important

HBM recommends a calibration cycle of one year.

Depending on the operational environment and the type
of plugs used for thermocouples, the connector contacts
may be subject to accelerated wear­out. The HBM Main­
tenance Package (see below) optionally includes
exchange of all device connectors.

HBM offers a Maintenance Package for MC1609
devices, which includes calibration and other benefits.
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More information contact HBM directly
(refer to 2.9 “Updates & Contact”).

A periodic maintenance of the device at HBM once per
year is necessary to prolong the warranty entitlement for
the device.

2.8 Disposal of old product

HBM products are designed and manufactured with high
quality materials and components, which can be recycled
and reused.

When this crossed­out wheeled bin symbol is attached to
a product it means the product is covered by the Euro­
pean Directive 2002/96/EC. Please inform yourself about
the local separate collection system for electrical and
electronic products. Please act according to your local
rules and do not dispose of your old products with normal
household waste. The correct disposal of your old prod­
uct will help prevent potential negative consequences for
the environment and human health.



Important Information

SomatCR A3686-1.1  HBM: public 15

2.9 Updates & Contact

HBM supports its products during the whole lifecycle.
Updates for all components (e.g. documents, configura­
tion software, device firmware, etc.) will be provided
when available.

It is highly recommended to visit the DOWNLOAD page
in the Support area on our web site approximately once
per month to stay up­to­date.

HBM, Inc.
19 Bartlett Street,
Marlborough, MA 01752
Tel: +1 800­578­4260
Fax: +1 508­485­7480
Sales Email: info@usa.hbm.com
Support Email: support@usa.hbm.com
Website: http://www.hbm.com

Web
German: http://www.hbm.com/de/
English: http://www.hbm.com/

Support
German: http://www.hbm.com/de/menu/support/
English: http://www.hbm.com/en/menu/support/

Download
German: http://www.hbm.com/de/menu/support/

software­firmware­downloads/
English: http://www.hbm.com/en/menu/support/

software­firmware­downloads/

mailto:info@usa.hbm.com
mailto:support@usa.hbm.com
http://www.hbm.com
http://www.hbm.com/de/
http://www.hbm.com/
http://www.hbm.com/de/menu/support/
http://www.hbm.com/en/menu/support/
http://www.hbm.com/de/menu/support/software-firmware-downloads/
http://www.hbm.com/de/menu/support/software-firmware-downloads/
http://www.hbm.com/en/menu/support/software-firmware-downloads/
http://www.hbm.com/en/menu/support/software-firmware-downloads/
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3 Handling

3.1 Mounting

Due to their rugged and compact design, MC1609
devices can be mounted nearly anywhere. However,
there are some limitations to ensure optimal performance
and product life.

Do not exceed the environmental limits (temperature,
humidity, vibration, etc.)

Use the existing screw­in holes on the rear side of the
device.

Don't forget to apply a suitable thread locker if necessary
(e.g. Loctite®).

Do not drill any additional holes into the housing!
Contact HBM (refer to 2.9 “Updates & Contact”) for infor­
mation about mounting kits for the devices.

In addition to the screw­in holes, the new generation of
MC1609 devices provides four oblong holes (two on each
side). Fastener straps (e.g. a cable tie) can be inserted
through these holes for easy fixing the device.

Notice

Do not drop the device! After a drop, especially on an
edge, the sealing may be harmed! Return the device to
HBM for a check.
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Notice

Do not mount with the connectors on the bottom. The
connectors should be on one side or the top of the
decive.

Notice

The mounting position should allow easy access to the
connectors to disconnect the power/CAN cable easily.

3.2 Cleaning

Remove all cable connections of MC1609 device before
cleaning.

Use a dry or slightly moistened cloth. If some dirt
remains, you may add some mild detergent.

Notice

Never use strong solvents or abrasive agents!
No liquids are allowed to flow into the device or its con­
nectors!
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3.3 Accessories

CAUTION

Always use genuine HBM parts like cables, mounting kits
etc.

HBM certified parts have been designed and validated
carefully in order to provide maximum benefits to the
user. Refer to chapter 6 “Cables” for a list of all available
cables. If you need a special cable to connect a
third­party device to the CAN bus, please contact HBM.
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4 First Steps

4.1 In the office or laboratory

1. Connect device to configuration platform.

�

�

�

� HBM MC1609

� CAN Interface Cable

� 16 Thermocouples
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1

4

3

2

5

CAN 00000

CAN 00000

computer with SomatCR
Assistant software
(NB: may require CANcard)

Inter­
face

1-KAB292-2

1-CONA1011

1-KAB291-2

� HBM MC1609. These devices are going to be
tested and configured.

� HBM Interface Cable (LEMO to eCOM M8 –
1­KAB292­2 where power is required the
1­KAB421­2 cable can be utilized)

� Computer with CANcard and HBM SomatCR
Assistant software installed.

� DAQ (QX/eDAQ) or CAN Interface
� HBM CAN Termination Plug (1­CONA1011)

The Interface Cable � is plugged into one of the CAN
connectors (type LEMO) of the MC1609 �. The other
end of the Interface Cable is connected to the eDAQ
Data Acquisition unit for usage, via the 9pin D Sub for
programming �.

For the SomatCR Assistant software, a standard
PC � is used (refer to 8.1 “System requirements”).

For reliable CAN communication it is important to ter­
minate the CAN bus using the CAN Termination
Plug (1­CONA1011) �.

2. Getting in contact with the device.

- Make sure the CAN power supply is switched on.
The green Power LED of the MC1609 � turns on. If
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not, please check your installation. If the problem
persists, refer to chapter 11 “Troubleshooting”.

- Launch HBM SomatCR Assistant application on the
computer �.

Refer to Software Documentation for more informa­
tion.

The complete software documentation (online help) is
installed during the setup process and can be found in
the Windows Start Menu at Programs / HBM /
SomatCR Assistant / Doc

- Select Options->Interface in the main menu to
configure your CAN interface:
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- Start automatic configuration of all connected HBM
devices by selecting File->Auto­Configuration ,
pressing the shortcut Ctrl­A or clicking the
Auto­Configuration icon  in the toolbar:
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A new document window is created showing the con­
nected MC1609 16, serial number 14136).

- Open the device dialog by double­clicking the line
with the  symbol:
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This dialog box shows device parameters like “Serial
number”, “Device name” or “Rate”. In addition it presents
buttons for several actions to be carried out with this
device, e.g. read or write the configuration or opening a
window for displaying the measurement values.

► Display the current measurement values of the device
by pressing the Button Measure in the Device dialog
box:
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- Channels with no thermocouple connected are dis­
played as "No Sensor". If available, plug in a ther­
mocouple in some of the channels to see the cor­
rect function.

- For copying the measurement values to the clip­
board the Button Copy will be used. Together with
the Checkbox to row you can choose between
copying the data in a row or each sensor value in a
new line.
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3. Setup the correct parameters for CAN and device.

- First, choose the CAN bus parameters used in your
installation. In most cases, this is "500000 Bits/s".
Double­click on the CAN bus icon  on the upper
left corner of the document window or select
Edit->Edit while the CAN bus line is marked:
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Important

Be careful when changing the CAN parameters! For most
cases the default values (500000 Bits/s) need not be
changed.

► Next, select suitable CAN identifiers for the device.

Important

If the device is going to be connected to an existing bus
with third­party devices make sure to use unique CAN
identifiers. Consult your CAN matrix or other documenta­
tion!
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► Finally, you can configure the channels of the device
(e.g. Channel name). Expand the tree view and dou­
ble­click on the line with the appropriate channel:
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4. Repeat steps 1. to 3. for all devices you are going to
use in your installation.

5. Install your devices.

Refer to chapter 7 “Installation” for important informa­
tion about power supply, topology and other topic!

For on­site configuration connect a computer with
SomatCR Assistant software and CANcard to the
CAN bus.

6. There are THREE different ways to prepare the
devices for the installation:
I. auto­configuration
II. scanning the bus and use the device's configura­

tion
III. applying an existing configuration file

- Auto­configuration (File->Auto­Configuration)
searches for all connected SomatCR Assistant
devices and automatically configures them in a
conflict­free manner.

On the site
(e.g. vehicle)
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If a conflict occurs (e.g. same identifiers on different
devices), the configuration of the affected device(s) is
changed and the new configuration is written back to
the device.

Important

Be careful!: Auto­Configuration changes the device's
configuration without confirmation.

- To perform a bus scan, open a new document
(File->New) and start the scan (File/Scan
CAN­Bus).
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Depending on the devices' configuration, conflicts
may occur. All affected devices are marked with a 
sign. Adjust the configuration manually (in the exam­
ple shown above: by setting the CAN identifier of
MC1609_14136 from 0x0180 to 0x0184) and activate
the devices again (Edit->Activate).

If there is no conflict left, you can re­configure all
devices (File->Reconfigure All or ).
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- Yet another way is to open a prepared configura­
tion file (File/Open). Then perform a check to
make sure that the installed devices and the config­
uration file are matching (File/Check Document).
A Check Report is generated:
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- If necessary, perform a re­configuration by select­
ing File->Reconfigure All. As an alternative, you
can write the configuration of a single device by
opening the corresponding device configuration
dialog box and selecting the button Write to
device.

7. Now, the configuration is completed.

It is recommended to save it to a new configuration
file (File->Save as) for further reference.
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8. All the devices on the CAN bus should operate per­
fectly now.

Check the LEDs of the MC1609 devices: the green
LED must be ON, the red LED must be OFF.

If a red LED is ON at one or more of the devices
check the configuration again. If third­party devices
are connected to the CAN bus, make sure that all
CAN identifiers are used by one device only!
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5 Connectors

All connectors are placed on the front side of MC1609:

� 16 connectors for thermocouples

� 2 LEMO connectors for CAN and power supply (on
the right)

Refer to chapter 9.1 “Indicator LEDs” for information
about the status of the LEDs.

CAUTION

The connector types for CAN and thermocouples have
been chosen because of their wide­spread usage in the
market. The standard version of MC1609 features sealed
connector housings in order to ensure IP6x protection of
the device.

However, the contacts of connectors and plugs (thermo­
couple cables) are not 100 % waterproof. HBM offers a
Maintenance Package for periodic service (refer to 2.7
“Maintenance & Calibration”).
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The following connector types are available:

5.1 Thermocouple Inputs

The MC1609 device provides 16 input channels for
NiCr­Ni (type K) sensors. The channels are fully isolated
among each other as well as towards the CAN interface
and the power supply.

The upper contact (near the channel numbers 1…16) is a
bit smaller than the other contact. Connect the "NiCr"
signal to this contact. The lower contact (next to MC1609
label) carries the "Ni" signal.

5.2 eDAQ (Data Acquisition System)

The HBM eDAQ system has to be connected with the
MC1609 using a special cable with a LEMO CAN/Power
connector (male) on one side and a SoMat M8 Pigtails
connector (male) on the other.

The power supply of the MC1609 is already provided by
the eDAQ system and no external supply in a single
chain is needed. For more chains another special cable
has to be used. Refer to chapter 6, “Cables” for more
information.
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SoMat M8 Female / Pigtails type: 1­KAB421­2

Pin Signal Description

1 SWC NA

2 CAN_H CAN high

3 AGnd power supply ground, CAN ground

4 not connected

5 Power + power supply, plus

6 CAN_L CAN low

Tab. 5.1 Pin allocation

5.3 CAN / Power Supply

MC1609 uses a combined connector for power supply
and CAN. There are two connectors (female) for outgo­
ing and incoming cables. This allows easy wiring with
only one thin cable between several MC1609 devices.
At the end of such a chain, a CAN termination resistor is
plugged into the remaining connector.

A variety of cables for power supply connection and
daisy­chaining between devices are available with differ­
ent cable lengths. Refer to chapter 6 “Cables” for more
information.

(view on
module
front)

1 2

3

4

5 6
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LEMO type: 1­KAB292­2

Pin Signal Description

1 Power + power supply, plus

2 Power GND power supply ground

3 CAN_H CAN high

4 CAN_L CAN low

5 CAN_GND CAN ground

Chassis Shield cable shield

Notice

Use genuine HBM cables for CAN connection only (refer
to chapter 6 “Cables”).

Notice

Both connectors have identical pin­out. The signals (CAN
bus, supply) are directly connected between the two con­
nectors.

(view on
module
front)

2

3 4

5

1
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6 Cables

HBM offers a complete variety of optimized MC1609
cables.

Benefits of genuine HBM MC1609 cables:

� low­drop power­supply lines

� shielded twisted­pair CAN lines

� temperature­resistant up to +150°C

� 100 % tested after production

Notice

It is highly recommended to use genuine HBM Cables
only!

6.1 Connection between two devices

6.1.1 MC1609 Connection Cable (1-KAB291-2/5/10)

ÓÓÓÓ
ÓÓÓÓ

ÓÓÓÓ
ÓÓÓÓ

1-KAB291-2

(male) (male)

Usage: connection (power, CAN) between MC1609 devices in a
daisy­chain

Length: various cable lengths are available (2 m, 5 m, 10 m)
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Connection: from CAN connector of one device to CAN connector of
another device or refer to 6.1.2 “MC1609 Cable Coupler”
for coupling two connection cables, please note that it is
best to use a cable of the correct length as opposed to
coupling multiple cables together.

Article No. Description

1-KAB291-2 SomatCR network cable (2 m)

1-KAB291-5 SomatCR network cable (5 m)

1-KAB291-10 SomatCR network cable (10 m)

1-KAB292-2 SomatCR eDAQ/CR cable (2.5 m)

1-KAB421-2 SomatCR Pwr/CR cable (2.5 m)

1-CONA1011 Terminator

6.1.2 MC1609 Cable Coupler

Available on request.

ÓÓÓÓ
ÓÓÓÓ
ÓÓÓÓ

ÓÓÓ
ÓÓÓ

REQUEST

(female) (female)

Usage: coupling of two Connections Cables for increased cable
length

Connection: between MC1609 Connection Cable
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6.1.3 MC1609 Connection Cable with Power Supply
(1­KAB423­2)

ÔÔ
ÔÔ

ÔÔÔ
ÔÔÔ

CAN & POWER

150 cm 100 cm

CAN only

(male)

300 cm

(male)

1-KAB423-2

Usage: power supply connection all devices connected to
daisy­chain
plus connection (power, CAN) between two MC1609
devices in the daisy­chain

Length: power supply cable 3.0 m
device connection cable 2.5 m

Connection: red banana plug for positive supply voltage (PLUS) black
banana plug for negative supply voltage (MINUS).
Refer to chapter 10.1 “Power Supply” for more informa­
tion about the allowed voltage range!

LEMO connectors: to connect a CAN connector of one
device with a CAN connector of another.

The supply is connected to the left LEMO connector
(male) only (CAN & POWER, marked by the label). The
right LEMO connector (male) carries the CAN signals
only.
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Notice

Make sure to connect only ONE CONNECTOR WITH
POWER SUPPLY to a device. (The connector with the
label has to be connected only once).

Article No. Description

1-KAB423-2 Power supply breakout for SomatCR to
eDAQ

Optional Cable for power from external device to
MC1609 device and Turck connector to eDAQ CAN Mod­
ule:

ÔÔÔ
ÔÔÔ

ÔÔÔ
ÔÔÔ

CAN & POWER

150 cm 100 cm

CAN only

(female)

300 cm

(male)

1-KAB421-2

Article No. Description

1-KAB421-2 Power supply breakout for SomatCR to
eDAQ CAN module
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6.2 Connection to CAN systems

6.2.1 MC1609 Interface Cable with Power Supply
(1­KAB292­2)

ÔÔÔ
ÔÔÔ

Ô
Ô

Ô
Ô
ÔÔ
ÔÔ

250 cm

1-KAB292-2

Usage: power supply connection for first MC1609 of a device
daisy­chain connection of CAN bus to an eDAQ system
with Somat M8 connector from eCom Interface.

Length: cable length available:
1­KAB292­2 2.5 m

Connection: SoMat M8 connector with pinout (Pin 1: SWC, Pin
2: CAN_H, Pin 3: AGnd, Pin 5: Power and Pin 6: CAN_L
refer to chapter 5.2 “eDAQ (Data Acquisition System)”)

LEMO connector to the first MC1609 device in
daisy­chain

Article No. Description

1-KAB292-2 MC1609 CAN Power from eDAQ 2.0 m with
M8 and LEMO
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6.2.2 CAN Termination Plug (1-CONA1011)

ÖÖÖ
ÖÖÖ

Usage: CAN bus termination at the end of a daisy­chain

Connection: plug into the remaining connector of the last MC1609
device in the daisy­chain

Article No. Description

1-CONA1011 MC1609 CAN Termination Plug



Installation

46 A3686-1.1  HBM: public SomatCR

7 Installation

7.1 Hints for power supply

HBM MC1609 devices are realized using a low­power
design with only 2 watts (typical) power consump­
tion. In addition with the genuine HBM cable (very
low voltage­drop on the power lines) and the minia­
turized geometry of the devices, a SIMPLE and
STRAIGHT­FORWARD INSTALLATION is possible in
most cases.

When choosing the power supply strategy, the following
parameters are relevant:

� minimum power supply voltage
This is the minimal value of the voltage supplied by
the power supply. In automotive applications, this is
usually the vehicle's on­board supply system (e.g.
"12V" for passenger cars). Note that the minimum
value is relevant. In a "12V" system this value can be
as low as 8 V (for several milliseconds) during starter
operation.

� number of MC1609 devices
Each device needs electrical power to operate (2 W
typical, refer to technical data in chapter 10.1
“Power Supply”). During power­up a temporary inrush
current is drawn, which may exceed the average
operating current. The power supply must be able to
provide enough current for all connected devices.

� cable length
The resistance of the connection cables cause a volt­
age loss along the cable, which is depending on the
cable length and the current through the cable. The
voltage at the last device in a supply chain must be
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within the specified range (8 V or higher, refer to tech­
nical data in chapter 10.1 “Power Supply”).

For typical applications, HBM recommends the fol­
lowing installation:

� supply voltage  12 V, total cable length  10 m:
up to 7 devices per power supply

� supply voltage  8 V, total cable length  10 m:
up to 5 devices per power supply

7.2 Simple chain

CAN 00000

eDAQ

CAN 00000

CAN 00000

CAN 00000

1-CONA1011

1-KAB291-2/5/10

1-KAB291-2/5/10

1-KAB291-2/5/10

1-KAB292-2
1-KAB421-2 with power computer with CANcard

and SomatCR Assistant
software

� The acquisition system (eDAQ) is connected to the
first MC1609 device with the integrated power and
CAN communications cable (1­KAB292­2). The
1­KAB421­2 can be used when power is required
externally such as when a CAN Smart Module is uti­
lized.
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� At the end of the CAN bus, a CAN Termination Plug
(1­CONA10111) is plugged into the remaining CAN
connector.

� The eDAQ system supplies the beginning of the
device chain. There are some limitations depending
on the number of devices, the cable length and the
minimum voltage of the power supply.
Refer to chapter 7.1 “Hints for power supply” for more
information.
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7.3 Long chain with additional power
supply

CAN 00000
eDAQ

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

1-KAB291-2/5/10

1-KAB292-2

computer with CANcard and
SomatCR Assistant software

1-KAB423-2

1-KAB291-2/5/10

1-KAB423-2

1-KAB291-2/5/10

1-CONA1011

1-KAB423-2

POWER
SUPPLY 2

POWER
SUPPLY 1
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� This example shows a more complex installation with
three clusters, each consisting of several MC1609
devices.

� All devices are connected to one CAN bus. At the end
of the CAN bus, a CAN Termination Plug
(1­CONA1011) is plugged into the remaining CAN
connector.

� Each cluster has its own power supply to minimize
voltage drops along the connection cables.

� When used on devices other than the HBM eDAQ,
the first unit must be connected to a suitable power
source. This can be achieved using one of the follow­
ing MC1609 cables; 1­KAB292­2 (M8 to MC1609),
1­KAB422­2 (9pin d­sub to MC1609 ) or 1­KAB296­2
 (open ‘pigtail’ to MC1609).

� Between the first and the second cluster, a MC1609
Connection Cable with Power Supply (label) is
installed. This cable directly connects the CAN bus
signals between the devices.
The power supply is routed only in forward direction,
towards the second cluster. There is no connection of
power lines between the two LEMO plugs of the
cable.
The two banana plug cables are connected to the
LEMO plug marked with the white label.

Notice

Make sure to install the MC1609 Connection Cable with
Power Supply (label) correctly ­ the marked LEMO plug
must be connected into one of the CAN connectors of
the first device in the second cluster.
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� The last cluster has its own power supply with a
MC1609 Connection Cable with Power Supply (label),
similar to the second cluster.

Refer to the previous chapter 7.1 “Hints for power supply”
for more information about choosing a suitable power
supply strategy.
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8 Configuration

MC1609 can be configured to use custom­specific
parameters for CAN transmission.

All configuration is done via the CAN interface of
MC1609. A powerful CAN configuration protocol is used
and provides convenient configuration of the MC1609.

Configuration is done using the Windows application
SomatCR Assistant, (SomatCR­Assistant.EXE) which is
shipped on disk with all devices.
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Refer to the online help of the application for more infor­
mation about configuration.

Important notes for configuration

Notice

It is necessary to operate with the correct CAN bit rate
during configuration, especially if third­party devices are
connected to the CAN bus.

Notice

If there are problems during configuration, disconnect all
third­party devices. If the problems still exist, contact
HBM support (refer to 2.9 “Updates & Contact”).

8.1 System requirements

Standard PC with Microsoft Windows operating system
Recommended: AMD Athlon/Pentium IV or better, Win­
dows XP, Vista and 7 (Vista/7 should be installed in
Administrator mode)

One of the following third­party CAN devices/drivers
should be installed successfully on the system:

Vector CAN (www.vector­informatik.de) 1

API: XL driver library 7.4

vxlapi.dll  7.4.50.0
vcanxl.sys / vcasexl.sys  7.3.18

1) Tested devices: Vector CANCard

Platform

CAN interface
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Kvaser CAN (www.kvaser.se) 2

API: CANLIB 4.0

canlib32.dll 6.09.4495
kcane.sys 6.09.4495

dSpace Generic CAN (www.dspace.de) 3

DCI­CAN1 adapter only

CanApi2.dll 2.47.1
DSCanApi10.dll 2.3.0.45
PCAN_USB.SYS 2.48.14.0

PEAK (www.peak­system.com) 4

PCAN­USB adapter only

Pcan_usb.dll 1.54.0
PCAN_USB_SYS 2.49.8.4514

Softing (www.softing.com) 5

API CAN Layer2 (V5.11)

canL2.dll 5.11.0.1
canusbw.sys 6.0.2.63

National Instruments (www.ni.com) 6

API: NI­CAN 2.5.2

nican.dll 2.5.0.49158
nicanpkw.sys 2.5.1f0

2) Tested device: Kvaser USBcan2
3) uses the PCAN driver and dSPACE API­DLL that is installed allong

with dSPACE CalDesk
Tested device: dSpaceCallDesk 2.0

4) PEAK At this time, the PEAK Lite – API is supported. PEAK
CANAPI2 is not yet supported
Tested device: PCAN­USB with PCAN Light API

5) Tested device: Softing CANusb
6) Tested device: NI PCMCIA­CAN Series 2
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IXXAT (www.ixxat.com) 7

API: NI­CAN 2.5.2

vcinpl.dll 1.0.0.1784
vci109w3.sys 3.1.4.1784

Support for other CAN devices are available upon
request.

8.2 Hints for usage

The factory default setting for MC1609 is as follows
(CANopen protocol):
CAN bit rate 500 000 Bits/s
Sample point 66 %
Identifier length 11­Bit (Standard­CAN)
Note ID 1
CAN identifier 0x0180 + NODE_ID, 0x0280 + 

NODE_ID,
0x0380 + NODE_ID and 0x0480 +
NODE_ID

Data format INTEL
Resolution 0.1 °C
Transmission rate 100 ms

It is highly recommended to do the basic configuration
(CAN bit rate, identifiers ...) for each device separately
(refer to chapter 4, especially 4.1
“In the office or laboratory”).

7) Tested device: IXXAT USB­to­CAN compact
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9 Operation

9.1 Indicator LEDs

On the front side of MC1609 one LED (Light Emitting
Diode) near the CAN connectors indicates the status of
operation (refer to CANopen DR­303­3 Indicator Specifi­
cation).

The LED can show one of the following different states:

OFF the LED is switched off

ON the LED is switched on

DOUBLE FLASH the LED is switched ON two times
(200 ms), the second time OFF is
1000 ms

SINGLE FLASH the LED is switched ON for 200 ms and
OFF for 1000 ms

BLINKING the LED is blinking (200 ms ON, 200 ms
OFF, and so on)

BLINK the LED is blinking (1 second ON, 1 sec­
ond OFF, and so on)

During normal operation (e.g. after power on), the green
"Power" LED is ON and the red "Error" LED is OFF.

The modules have also a per­channel indicator. Refer
to 9.1.2 “Channel Indicator LED's” for details.



Operation

SomatCR A3686-1.1  HBM: public 57

9.1.1 Description

OFF no power supply

ON (green) the Device is in OPERATIONAL state

SINGLE FLASH
(green)

the Device is in STOPPED state

BLINKING (green) the Device is in PREOPERATIONAL
state

OFF (red) the Device is in working condition

ON (red) the Device is bus off (bus off handled by
CAN controller)

DOUBLE FLASH
(red)

a guard event or a heartbeat event has
occurred

BLINK (green/red) firmware download in progress

9.1.2 Channel Indicator LED's

OFF there is a thermo couple connected

ON (red) there is no thermo couple connected
(sensor break)

9.2 CAN Communication

During normal mode of operation (refer to 9.1
“Indicator LEDs”), MC1609 is periodically transmitting
CAN messages containing the measured temperatures.

The CAN bus parameters (e.g. bit rate) as well as the
CAN messages (e.g. identifier, transmission rate) can be
configured. Refer to chapter 8 “Configuration” for more
information.
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9.2.1 Messages

ID Rate DLC
DATA

0
DATA

1
DATA

2
DATA

3
DATA

4
DATA

5
DATA

6
DATA

7

0x0181 rate 8
CH1 CH2 CH3 CH4

0x0182 rate 8
CH5 CH6 CH7 CH8

0x0183 rate 8
CH9 CH10 CH11 CH12

0x0184 rate 8
CH13 CH14 CH15 CH16

The CAN identifier (ID) of the first CAN message can be
configured with “SomatCR Assistant” (refer to chapter 8
“Configuration”).

The rate of the CAN messages containing the data of
channel 1 to 16 (CH1…CH16) can be configured (5 ms,
10 ms, 20 ms, 50 ms, 100 ms, 200 ms, 500 ms, 1000 ms,
2000 ms or 5000 ms).

Refer to 9.2.2 “Signals” for a description of DATAx bytes
in the messages.

9.2.2 Signals

CH1 … CH16

description: Temperature value of thermocouple input

resolution: 0.1 °C

range: ­100.0 °C … +1372.0 °C or 0xFC18 … 0x3598 respec­
tively
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sensor break: Special value if no thermocouple is detected at the input
0x8000

format: INTEL (LSB first)
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10 Technical Data

As with many electronic devices, the measurement accu­
racy of the MC1609 is determined by both the installation
and the conditions under which the device is utilized.

For example; when the device is used in ambient condi­
tions between ~ ­10°C and ~ +50°C with measurements
of up to 1100°C the accuracy is ≤0.5°C, whereas when
the ambient temperature is less than ­30°C or greater
than +85°C this level of accuracy falls at about ≤0.5°C
per 15°C (either direction) as measurement inputs
increase above 1150°C .

Important

The above accuracy values are based on the use of
cables of ≤3M see section 2.4.

10.1 Power Supply

Voltage range ca. 8 V to 42 V DC

Power consumption 2.0 W typical (16 channels)

Connectors LEMO (type 0B) for HBM cables (refer to chapter 6 “Cables”)

Safety fuse External safety fuse is recommended for un-fused power sup­
ply. The fuse must open after 120 s max. at 4.76 A. For exam­
ple, a standard ATO fuse with “2A” can be used.
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10.2 Inputs

Channels 16 input channels

Sensor NiCr­Ni (type K) thermocouples
Fe-CuNi (type J) thermocouples
Cu-CuNi (type T) thermocouples

Connectors Miniature thermo connectors

Measurement range Type K: ­100 °C to +1372 °C (­148 °F to +2501 °F)
Type J: -100 °C to +1200 °C (-148 °F to 2192 °F)
Type T: -100 °C to +400 °C (-148 °F to 752 °F)

Measurement
resolution

16 Bits

Measurement unit 0.1 °C

Measurement
accuracy

Please refer to table (located at the end of this section). For
additional information please contact your local HBM support
office.

Internal sampling rate 1000 Hz

Measuring rate 1/5 Hz, 1/2 Hz, 1 Hz, 2 Hz, 5 Hz, 10 Hz, 20 Hz, 50 Hz, 100 Hz,
200 Hz

Input filter Low­pass filter with digital filtering

Features Detection of broken sensor connection,
Separate reference junction for each channel

Input protection ±60 V permanent, ESD protection

Isolation voltage 500 V DC between input channels
500 V DC between input channel and power supply
500 V DC between input channel and CAN
500 V DC between power supply and CAN
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10.3 CAN Interface

CAN specification CANopen (EN 50325­4)

Physical layer High­speed CAN (ISO 11898)

Bit rate 125 kBits/s, 250 kBits/s, 500 kBits/s (default), 1 MBits/s

Connectors LEMO (type 0B) for HBM cables (refer to chapter 6 “Cables”)

10.4 Configuration

Interface Via CAN bus

Protocol Compatible to all other MC1609 devices

Storage Non­volatile memory in the device

Usage Windows application SomatCR Assistant
(SomatCR­Assistant.EXE)

10.5 Dimensions

Size (W x H x D) Approx. 200 x 35 x 50 mm³ (77/8" x 13/8" x 2")

Weight Approx. 500 g (approx. 173/5 oz.)
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Fig. 10.1 Accuracy matrix
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10.6 Mounting

Mounting holes

Screw Size: M4 x 10 mm

X

Yvent

Rear View

X = 194 mm Y = 29 mm

CAUTION

Do not cover vent! Do not poke! Refer chapters 2.5, 2.6,
2.9 !!

For detailed drawings call HBM.
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10.7 Environmental Condition

Standard version

Operating
temperature

­40 °C to +120 °C 
(approx. ­40 °F to +250 °F)

Humidity 5 % to 95 % (non-condensing)

Altitude 0 m to 2000 m

Protection IP65

Pollution degree 3 (according to IEC 60664-1)
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11 Troubleshooting

As a first step, read the following topic headlines written
in bold. Maybe the solution for your problem can be
found there quickly.

The "Power" LED remains OFF all the time

Make sure that your supply voltage is in the specified
range (refer to chapter 10.1 “Power Supply”).

Use an appropriate cable for power supply 
(refer to chapter 6 “Cables”).

Another cause may be a hardware failure of the device.
Contact HBM (refer to chapter 2.9 “Updates & Contact).

I need support from HBM

If you need assistance, use our Support Form on the
Web (refer to chapter 2.9 “Updates & Contact”).
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1 Einleitung

Die MC1609-Geräte von HBM sollen eine kostengünstige
und per Plug&Play einzurichtende Möglichkeit zur Erwei­
terung des HBM-Datenerfassungssystems Somat eDAQ
bereitstellen. Es handelt sich um ein Peripheriegerät und
damit um eine in der Praxis problemlos realisierbare Lö­
sung zum Einsatz in Verbindung mit weiterer kompatibler
Hardware wie QuantumX, die MGC-Serie usw., die dem
Standard CANopen entsprechen.

Das Gerät ist zur Remote-Installation (entfernt vom
Hauptsystem) vorgesehen und kann daher relativ einfach
auf einer Trägerkonstruktion befestigt werden. Es erfüllt
dabei die thermischen Bedingungen, die sich ggf. aus
seiner Positionierung ableiten. Mit Hilfe der Durchfüh­
rungen können mehrere Geräte miteinander in Reihe ver­
kettet werden, um größere Kanalzusammenstellungen zu
erhalten.

Merkmale (MC1609)

� 16 Eingänge in einem kompakten Gehäuse für
Thermoelemente

- Typ K (NiCr-Ni): -100,0 °C bis +1372,0 °C

- Typ J (Fe-CuNi): -100,0 °C bis +1200,0 °C

- Typ T (Cu-CuNi): -100,0 °C bis +400,0 °C

� Hervorragende Genauigkeit (Tiefpass-/Digitalfilterung,
Linearisierung, Temperaturkompensation, …)

� Interne Abtastrate 1000 Hz pro Kanal

� Messrate 0,5 Hz bis 10 Hz für alle Kanäle (vom
Benutzer konfigurierbar)

� Erkennung von fehlendem oder defektem Thermo­
elementsensor
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� Überspannungsschutz ±60 V (Dauerbelastung) an
Sensoreingängen

� Auf nationale Norm rückführbare Kalibrierung im Leis­
tungsumfang enthalten

� Kanalanzeige-LEDs

� Hochgeschwindigkeits-CAN-Schnittstelle (Standard
500 kBit/s, max. 1 MBit/s)

� Konfiguration aller CAN-Parameter (Standard-CAN,
Abtastpunkt, Identifier, …)

� Systeminterne Konfiguration mit moderner Software
SomatCR Assistant

� CAN-System mit identischen LEMO-Anschlüssen (pa­
rallel angeschlossen) für einfache Installation von
CAN-Bus und Stromversorgung

� Spannungsversorgungsbereich ca. +8 V …+42 V,
ideal für Standard-Bordnetzsysteme von 12 / 24 /
42 V

� Geringe Leistungsaufnahme (typischer Wert: 2 W)

� 500 V Isolationsspannung zwischen Kanal, CAN-
Schnittstelle und Stromversorgung

� Robustes und kompaktes Gehäuse

� Anwenderfreundlich; weitere Informationen finden Sie

in Kapitel 4 „Erste Schritte“.

Betriebsumgebung

� Betriebstemperatur: ­40 °C bis +120 °C

� Schutzart des Geräts: IP65
Verschmutzungsgrad 3 (nach IEC 60664­1)

� Geeignet für den Betrieb im Motorraum
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Konfiguration

� Komfortable Konfiguration über CAN

� Benutzerfreundliche Windows-Anwendung mit
automatischen Erkennungs- und Konfigurations­
funktionen

� CANdb-kompatible Signaldatenbank für alle ange­
schlossenen Geräte



Wichtige Informationen

SomatCR A3686-1.1  HBM: public 7

2 Wichtige Informationen

2.1 Symbole

Hinweis

Beachten Sie alle bei diesem Zeichen gegebenen Anwei­
sungen, um Verletzungen, Gefahren oder Schäden zu
vermeiden!

WARNUNG

Beachten Sie alle bei diesem Zeichen gegebenen Anwei­
sungen, um Verletzungen, Gefahren oder Schäden zu
vermeiden!

Wichtig

Stellen Sie sicher, dass Sie alle bei diesem Zeichen
gegebenen Informationen verstanden haben, um alle
Vorteile des Systems nutzen zu können.

2.2 Haftung

Wir behalten uns das Recht vor, technische Änderungen
an Hardware, Software und Dokumenten ohne vorherige
Ankündigung durchzuführen.

HBM übernimmt keine Haftung für Schäden jeglicher Art,
die direkt oder indirekt durch die Nutzung von Geräten
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oder zugehöriger Software oder durch Fehler oder Aus­
lassungen in der Dokumentation verursacht werden.

Hardware, Software und Dokumentation werden ohne
Mängelgewähr („as is“) und ohne jede Garantien bezüg­
lich ihrer Funktion in den Systemen des Endkunden be­
reitgestellt.

VORSICHT

Ein nicht der Spezifikation entsprechender Gebrauch
kann den Schutz beeinträchtigen.

VORSICHT

Verwenden Sie immer von HBM zertifizierte Teile, z. B.
Kabel, Einbausätze usw.

2.3 CAN-Warnung

Wir empfehlen, Datenerfassungsgeräte wie MC1609 an
einen separaten CAN-Bus (den sogenannten „Messbus“)
anzuschließen. Dies sichert maximale Leistung für die
Messung und minimiert die Risiken von Störungen am
vorhandenen CAN-Bussystem.

Besondere Vorsicht ist geboten, wenn Fremdgeräte an
einen Messbus mit MC1609-Geräten von HBM ange­
schlossen werden. Achten Sie darauf, dass miteinander
kompatible Konfigurationseinstellungen für alle Geräte
verwendet werden (gleiche CAN-Bitrate, unterschiedliche
CAN-Identifier usw.)
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WARNUNG

Die Nutzung von MC1609-Geräten kann gefährlich sein!
Nur für qualifiziertes, geschultes Personal!

Der Anschluss eines MC1609-Geräts an ein be­
stehendes CAN-Bussystem (z. B. Fahrzeug- oder
Automatisierungssystem) kann das Verhalten des CAN-
Bus beeinträchtigen. Dies kann schwere Personen- oder
Sachschäden zur Folge haben. Die Nutzung von
MC1609-Geräten ist nur für Personen gestattet, die sich
mit Funktionalität und Handhabung auskennen.

Zur Vermeidung von Risiken jeder Art sind folgende
Richtlinien zu beachten:

� Lesen Sie diese Anleitung, und vergewissern Sie sich,
dass Sie sie verstanden haben.

� Verwenden Sie korrekte Konfigurationen (gilt ins­
besondere für CAN-Parameter).

� Beachten Sie beim Herstellen des Anschlusses an Ihr
CAN-Bussystem alle relevanten Sicherheitsvorkeh­
rungen.

HBM übernimmt KEINE HAFTUNG für Fehler,
Schäden oder Verletzungen, die durch unbefugte,
unsachgemäße oder nicht korrekte Handhabung von
MC1609-Geräten entstehen.

Wenden Sie sich bei Fragen sofort und BEVOR Sie
MC1609-Geräte nutzen an HBM. Die Kontaktdaten
finden Sie in Kapitel 2.9.
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2.4 EMV-Informationen

HBM erklärt, dass das in dieser Anleitung beschriebene
Produkt die Anforderungen der Europäischen EMV-Richt­
linie 2004/108/EG erfüllt, wenn es zusammen mit Kabeln
bis zu einer Länge von 3 m verwendet wird. Von der
Verwendung von MC1609 in Verbindung mit Kabeln von
mehr als 3 m Länge ist abzuraten. Dadurch würde das
System die Spezifikationen für elektromagnetische Stör­
festigkeit überschreiten. Da das System für eine „ortsge­

bundene“ Installation konzipiert ist, lässt sich dies bei der
Installation leicht vermeiden. Weitere Informationen
erhalten Sie bei dem für Sie zuständigen Support.

Hinweis

MC1609-Geräte von HBM sind Produkte der Klasse A. In
einer häuslichen Umgebung können diese Produkte
Funkstörungen verursachen. In diesem Fall muss der
Anwender ggf. geeignete Maßnahmen treffen.

2.5 Vorsichtsmaßnahmen bei
Handhabung / Montage

MC1609-Geräte sind mit einer GORE� Membran aus­
gestattet, die eine entscheidende Voraussetzung für die
Druck- und Feuchtigkeitsregulierung ist. Dies ist erforder­
lich, um mit den rasch wechselnden Umgebungstempe­
raturen in Fahrzeugen zurechtzukommen.

Es handelt sich um eine geeignete und allgemein übliche
Methode.
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Die kleine Entlüftungsöffnung im Gerätegehäuse muss
stets offen und frei sein. Wenn dies nicht eingehalten
wird, kann sich Kondensationsfeuchtigkeit im Gehäuse
ansammeln und zu dauerhaften Schäden am Gerät füh­
ren.

An der Entlüftungsöffnung stehendes Wasser schädigt
die Membran! Wenn das Gerät an einem Ort installiert
wird, an dem sich Wasser oder andere Flüssigkeiten
sammeln, muss das Gerät so eingebaut werden, dass
die kleine Entlüftungsöffnung im Gerätegehäuse offen
und frei ist, damit Flüssigkeiten ablaufen können. An der
Entlüftungsöffnung stehende Flüssigkeiten können zu
dauerhaften Schäden an der Membran führen! Das Gerät
verliert dann die durch IP65 definierten Eigenschaften.

VORSICHT

Decken Sie diese Öffnung nicht ab. Die Luft muss frei
zirkulieren können!

VORSICHT

Führen Sie keine Gegenstände in diese Öffnung ein, dies
würde die Membran zerstören.
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VORSICHT

Schrauben Sie keine Schrauben an der Vorderseite ab.
Dies könnte den IP6x­Schutz des Geräts beein­
trächtigen.

VORSICHT

Achten Sie darauf, dass die Geräte sicher montiert
werden, um Schäden zu vermeiden.

VORSICHT

Bauen Sie das Gerät nicht mit den Anschlüssen an der
Unterseite ein. Die Anschlüsse sollten sich an einer Sei­
tenwand oder an der Oberseite des Geräts befinden.

VORSICHT

Die Einbaulage sollte einen einfachen Zugang zu den
Anschlüssen ermöglichen, um das Stromversor­
gungs-/CAN-Kabel leicht abziehen zu können.
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VORSICHT

Bei einem Betrieb in heißen Umgebungen (z. B. im Mo­
torraum) kann die Oberfläche des Geräts ebenfalls heiß
werden. Lassen Sie das Gerät vor der Handhabung
abkühlen, oder verwenden Sie einen geeigneten Schutz.

2.6 Sicherheit

Die Bauweise aller MC1609-Geräte entspricht den ein­
schlägigen Sicherheitsnormen. Sie werden unter der
Überwachung durch ein Qualitätsmanagementsystem
nach ISO 9000 gefertigt.

VORSICHT

Öffnen Sie das Gerät nicht. In seinem Innern befinden
sich keine wartungsfähigen Teile.
Nehmen Sie keine mechanischen oder elektrischen
Änderungen vor.
Lösen Sie auch nicht die Schrauben an der Vorderseite.

Die Schutzart IP6x kann durch unbefugte Manipulation
des Geräts verloren gehen!

Hinweis

Vergewissern Sie sich vor dem Anschließen eines
Kabels, dass die anliegenden Signale (Stromversorgung,
Thermoelemente) innerhalb des zulässigen Bereichs

liegen (siehe Kapitel 10 „Technische Daten“).
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Hinweis

Im Fahrzeug kann es zu einem Potentialunterschied über
die Abschirmung der Schnittstellenkabel der Geräte kom­
men! Montieren Sie die Geräte nur an Komponenten mit
dem gleichen elektrischen Potential, oder isolieren Sie
die Geräte gegenüber den Komponenten.

VORSICHT

Statten Sie die Stromversorgung zur Vermeidung von
Brandgefahren mit einer Schutzsicherung aus. Die Si­
cherung muss nach maximal 120 Sekunden bei 4,76 Am­
pere öffnen.

Hinweis

Vergewissern Sie sich, dass das Gerät korrekt installiert
ist. Betreiben Sie das Gerät nur innerhalb der spezifi­
zierten Umgebung (siehe Kapitel 10

„Technische Daten“).

Alle Eingangskanäle sind untereinander sowie gegenüber
der Versorgungsspannung und dem CAN galvanisch ge­
trennt. Diese funktionelle Trennung ist für 500 V DC be­
messen. Eine Typgenehmigung mit einer Prüfspannung
von 500 V DC wurde erfolgreich durchgeführt.
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Wichtig

Bei der oben genannten galvanischen Trennung von
500 V DC handelt es sich um eine funktionelle Trennung,
die in der Routineprüfung nicht getestet wird.
Deshalb dürfen MC1609-Geräte von HBM nur für
Messungen mit Spannungen bis max. 60 V DC
verwendet werden.

HBM übernimmt KEINE HAFTUNG für die Verwendung
mit höheren Spannungen als 60 V DC.

2.7 Wartung und Kalibrierung

Alle MC1609-Geräte werden mit einem Kalibrierzertifikat
ausgeliefert, das von einem rückverfolgbaren nationalen
Kalibrierlabor ausgestellt ist.

Wichtig

HBM empfiehlt einen Kalibrierzyklus von einem Jahr.

Je nach Betriebsbedingungen und Typ der für Thermo­
elemente verwendeten Stecker können sich die Steck­
kontakte schnell abnutzen. Das HBM-Wartungspaket
(siehe unten) umfasst als Option den Austausch aller
Geräteanschlüsse.

HBM bietet ein Wartungspaket für MC1609-Geräte an,
das neben der Kalibrierung noch weitere Vorteile bietet.
Weitere Informationen erhalten Sie direkt bei HBM
(siehe Kapitel 2.9 „Updates und Kontakt“).
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Eine regelmäßige Wartung des Geräts bei HBM einmal
pro Jahr ist Voraussetzung für die Verlängerung des Ge­
währleistungsanspruchs für das Gerät.

2.8 Entsorgung des Altgeräts

HBM-Geräte werden mit hochwertigen Materialien und
Komponenten konstruiert und gefertigt, die recyclingfähig
oder wiederverwendbar sind.

Wenn dieses durchgestrichene Mülltonnen­Symbol an
einem Produkt angebracht ist, bedeutet dies, dass das
Produkt unter die Europäische Richtlinie 2002/96/EG
fällt. Bitte informieren Sie sich über örtliche
Mülltrennungssysteme für Elektro- und Elektronikgeräte.
Bitte handeln Sie entsprechend den für Sie geltenden
örtlichen Vorschriften, und entsorgen Sie Ihre Altgeräte
nicht mit dem normalen Hausmüll. Die korrekte Entsor­
gung Ihres Altgeräts trägt dazu bei, möglicherweise ne­
gative Folgen für die Umwelt und die menschliche
Gesundheit zu vermeiden.
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2.9 Updates und Kontakt

HBM unterstützt seine Produkte während ihres gesamten
Lebenszyklus. Updates für alle Komponenten (z. B. Do­
kumente, Konfigurations-Software, Geräte-Firmware
usw.) werden bei Verfügbarkeit bereitgestellt.

Es wird nachdrücklich empfohlen, die Seite DOWNLOAD
im Support-Bereich auf unserer Website ungefähr einmal
pro Monat zu besuchen, um diesbezüglich auf dem
Laufenden zu bleiben.

HBM, Inc.
19 Bartlett Street,
Marlborough, MA 01752
Tel: +1 800­578­4260
Fax: +1 508­485­7480
E-Mail Vertrieb: info@usa.hbm.com
E-Mail Support: support@usa.hbm.com
Internet: http://www.hbm.com

Internet
Deutsch: http://www.hbm.com/de/
Englisch: http://www.hbm.com/

Support
Deutsch: http://www.hbm.com/de/menu/support/
Englisch: http://www.hbm.com/en/menu/support/

Download
Deutsch: http://www.hbm.com/de/menu/support/

software­firmware­downloads/
Englisch: http://www.hbm.com/en/menu/support/

software­firmware­downloads/

mailto:info@usa.hbm.com
mailto:support@usa.hbm.com
http://www.hbm.com
http://www.hbm.com/de/
http://www.hbm.com/
http://www.hbm.com/de/menu/support/
http://www.hbm.com/en/menu/support/
http://www.hbm.com/de/menu/support/software-firmware-downloads/
http://www.hbm.com/de/menu/support/software-firmware-downloads/
http://www.hbm.com/en/menu/support/software-firmware-downloads/
http://www.hbm.com/en/menu/support/software-firmware-downloads/


Handhabung

18 A3686-1.1  HBM: public SomatCR

3 Handhabung

3.1 Montage

Aufgrund ihrer robusten und kompakten Bauweise
können MC1609-Geräte nahezu überall montiert werden.
Um eine optimale Leistung und Produktlebensdauer si­
cherzustellen, gelten allerdings gewisse Ein­
schränkungen.

Überschreiten Sie nicht die Grenzwerte für Umgebungs­
bedingungen (Temperatur, Feuchtigkeit, Schwingung
usw.).

Verwenden Sie die vorhandenen Schraubenlöcher an der
Rückseite des Geräts.

Vergessen Sie nicht, bei Bedarf eine geeignete Ge­
windesicherung (z. B. Loctite®) aufzutragen.

Bohren Sie keine zusätzlichen Löcher in das Gehäuse!
Wenden Sie sich bezüglich weiterer Informationen zu
Einbausätzen für die Geräte an HBM (siehe Kapitel 2.9

„Updates und Kontakt“).

Zusätzlich zu den Schraublöchern bieten die
MC1609-Geräte der neuen Generation auch vier Langlö­
cher (zwei auf jeder Seite). Durch diese Löcher können
Befestigungsstreifen (z. B. ein Kabelbinder) zur einfa­
chen Befestigung des Geräts eingeführt werden.
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Hinweis

Lassen Sie das Gerät nicht fallen! Nach einem Sturz,
insbesondere auf eine Kante, kann die Abdichtung
beschädigt sein! Schicken Sie das Gerät zur Kontrolle an
HBM.

Hinweis

Bauen Sie das Gerät nicht mit den Anschlüssen an der
Unterseite ein. Die Anschlüsse sollten sich an einer Sei­
tenwand oder an der Oberseite des Geräts befinden.

Hinweis

Die Einbaulage sollte einen einfachen Zugang zu den
Anschlüssen ermöglichen, um das Stromversor­
gungs-/CAN-Kabel leicht abziehen zu können.

3.2 Reinigung

Entfernen Sie vor dem Reinigen alle Kabelanschlüsse
des MC1609-Geräts.

Verwenden Sie ein trockenes oder leicht angefeuchtetes
Tuch. Zum Entfernen von hartnäckigem Schmutz kann
ein wenig mildes Reinigungsmittel zugegeben werden.
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Hinweis

Verwenden Sie auf keinen Fall starke Lösungsmittel oder
Scheuermittel!
Flüssigkeiten dürfen nicht in das Gerät oder seine An­
schlüsse gelangen!

3.3 Zubehör

VORSICHT

Verwenden Sie immer HBM-Originalteile, z. B. Kabel,
Einbausätze usw.

HBM-Originalteile sind sorgfältig daraufhin ausgelegt und
validiert, das sie dem Anwender einen optimalen Nutzen
bieten. Eine Liste aller verfügbaren Kabel finden Sie in

Kapitel 6 „Kabel“. Wenn Sie ein Spezialkabel für den An­
schluss eines Fremdgeräts an den CAN-Bus benötigen,
wenden Sie sich bitte an HBM.
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4 Erste Schritte

4.1 In Büro oder Labor

1. Schließen Sie das Gerät an die Konfigurations­
plattform an.

�

�

�

� HBM MC1609

� CAN-Schnittstellenkabel

� 16 Thermoelemente
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1

4

3

2

5

CAN 00000

CAN 00000

Computer mit Software
SomatCR Assistant
(Hinweis: erfordert ggf.
CANcard)

Schnitt‐
stelle

1-KAB292-2

1-CONA1011

1-KAB291-2

� HBM MC1609. Diese Geräte werden getestet und
konfiguriert.

� HBM-Schnittstellenkabel (LEMO an eCOM M8 –
1­KAB292­2; wenn Stromversorgung benötigt wird,
kann das Kabel 1­KAB421­2 verwendet werden)

� Computer mit CANcard und installierter HBM-Soft­
ware SomatCR Assistant

� DAQ (QX/eDAQ) oder CAN-Schnittstelle
� HBM CAN-Abschlussstecker (1­CONA1011)

Das Schnittstellenkabel � wird in einen der CAN-An­
schlüsse (Typ LEMO) von MC1609 � eingesetzt. Das
andere Ende des Schnittstellenkabels wird mit der
eDAQ-Datenerfassungseinheit  verbunden, um sie
über den 9-poligen D-Sub-Anschluss zur Program­
mierung  � zu verwenden.

Für die Software SomatCR Assistant wird ein Stan­
dard-PC � verwendet (siehe Kapitel 8.1

„Systemvoraussetzungen“).

Für eine zuverlässige CAN-Kommunikation ist es
wichtig, dass der CAN-Bus unter Verwendung des
CAN-Abschlusssteckers (1­CONA1011) � abge­
schlossen wird.
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2. Machen Sie sich mit dem Gerät vertraut.

- Vergewissern Sie sich, dass die CAN-Stromversor­
gung eingeschaltet ist. Um dies anzuzeigen, leuch­
tet die grüne Stromversorgungs-LED des
MC1609 �. Wenn nicht, kontrollieren Sie Ihre In­
stallation. Wenn das Problem weiterhin besteht,
sehen Sie in Kapitel 11 „Fehlerbehebung“ nach.

- Starten Sie die Anwendung HBM SomatCR As­
sistant auf dem Computer �.

Weitere Informationen finden Sie in der Software-Do­
kumentation.

Die vollständige Software-Dokumentation (Online-
Hilfe) wird während des Setup-Prozesses installiert
und ist im Start-Menü von Windows unter Programme
/ HBM / SomatCR Assistant / Doc zu finden.

- Wählen Sie im Hauptmenü Options->Interface
(Optionen -> Schnittstelle), um die CAN-Schnitt­
stelle zu konfigurieren:
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- Starten Sie die automatische Konfiguration aller
angeschlossenen HBM-Geräte über die Auswahl
File->Auto­Configuration  (Datei -> Automatische
Konfiguration), durch Drücken der Tastenkombina­
tion Strg­A oder durch Anklicken des Symbols
„Auto­Configuration “  in der Symbolleiste:
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Ein neues Dokumentfenster wird geöffnet, in dem das
angeschlossene MC1609 (16 Kanäle, Seriennummer
14136) angezeigt wird.

- Öffnen Sie den Gerätedialog, indem Sie auf die
Zeile mit dem Symbol  doppelklicken:
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In diesem Dialogfeld werden die Geräteparameter wie
„Serial number“ (Seriennummer), „Device name“ (Gerä­

tename) oder „Rate“ (Übertragungsrate) angezeigt.
Außerdem enthält es Schaltflächen für verschiedene Ak­
tionen, die mit diesem Gerät ausgeführt werden können,
z. B. Lesen oder Schreiben der Konfiguration oder Öff­
nen eines Fensters zum Anzeigen der Messwerte.

► Lassen Sie die aktuellen Messwerte des Geräts
anzeigen, indem Sie auf die Schaltfläche Measure
(Messen) im Geräte-Dialogfeld klicken:
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- Kanäle, an die kein Thermoelement angeschlossen
ist, werden als „No Sensor“ (Kein Sensor) ange­
zeigt. Schließen Sie, sofern verfügbar, Thermo­
elemente an einige der Kanäle an, um ihre korrekt
Funktion zu überprüfen.

- Zum Kopieren der Messwerte in die Zwischenab­
lage wird die Schaltfläche Copy (Kopieren)
verwendet. Durch Aktivieren bzw. Deaktivieren des
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Kontrollkästchens to row (in Reihe) können Sie
auswählen, ob die Daten in einer Reihe kopiert
oder jeder Sensorwert in eine neue Zeile ge­
schrieben wird.

3. Stellen Sie die korrekten Parameter für CAN und
Gerät ein.

- Wählen Sie zuerst die in Ihrer Installation
verwendeten CAN-Bus-Parameter. In den meisten
Fällen sind dies „500000 Bits/s“. Doppelklicken Sie

auf das CAN-Bus-Symbol  in der oberen linken
Ecke des Dokumentfensters, oder wählen Sie
Edit->Edit (Bearbeiten -> Bearbeiten), während die
Zeile des CAN-Bus markiert ist:
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Wichtig

Vorsicht beim Ändern der CAN-Parameter! In den meis­
ten Fällen brauchen die Standardwerte (500000 Bits/s)
nicht geändert zu werden.

► Wählen Sie als Nächstes geeignete CAN-Identifier
(IDs) für das Gerät.
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Wichtig

Wenn das Gerät an einen bestehenden Bus mit Geräten
anderer Hersteller angeschlossen werden soll, achten
Sie darauf, eindeutige CAN-Identifier zu verwenden. Se­
hen Sie in Ihrer CAN-Matrix oder sonstiger Dokumenta­
tion nach!

► Zum Schluss können Sie die Kanäle des Geräts konfi­
gurieren (z. B. den Kanalnamen). Erweitern Sie die
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Baumansicht, und doppelklicken Sie auf die Zeile mit
dem entsprechenden Kanal:
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4. Wiederholen Sie die Schritte 1. bis 3. für alle Ge­
räte, die in Ihrer Installation verwendet werden
sollen.

5. Installieren Sie Ihre Geräte.

Wichtige Informationen zu Stromversorgung, Topolo­
gie und weiteren Themen finden Sie in Kapitel 7

„Installation“!

Für die Konfiguration vor Ort  schließen Sie einen
Computer mit der Software SomatCR Assistant und
CANcard an den CAN-Bus an.

6. Es gibt DREI unterschiedliche Möglichkeiten, die
Geräte für die Installation vorzubereiten:
I. Automatische Konfiguration
II. Abtasten des Bus und Verwenden der gefundenen

Gerätekonfiguration
III. Anwenden einer vorhandenen Konfigurationsdatei

- Auto­configuration (File->Auto­Configuration)
(Datei -> Automatische Konfiguration) sucht nach
allen angeschlossenen Geräten mit dem SomatCR
Assistant und konfiguriert sie automatisch in einer
konfliktfreien Weise.

Vor Ort
(z. B. Fahrzeug)
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Wenn ein Konflikt auftritt (z. B. gleiche Identifier bei
unterschiedlichen Geräten), wird die Konfiguration des
(der) betroffenen Geräts (Geräte) geändert, und die
neue Konfiguration wird in das Gerät zurückge­
schrieben.

Wichtig

Vorsicht! Die Funktion „Auto­Configuration“ ändert die
Gerätekonfiguration, ohne nach einer Bestätigung zu
fragen.
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- Um eine Busabtastung durchzuführen, öffnen Sie
ein neues Dokument (File->New) (Datei -> Neu)
und starten die Abtastung (File/Scan CAN­Bus)
(Datei/CAN-Bus abtasten).

Je nach Gerätekonfiguration können Konflikte auftre­
ten. Alle betroffenen Geräte sind mit einem Warn­
schild  markiert. Passen Sie die Konfiguration ma­
nuell an (im oben gezeigten Beispiel: durch Ändern
der Einstellung des CAN-Identifiers für
MC1609_14136 von 0x0180 in 0x0184), und ak­
tivieren Sie die Geräte erneut (Edit->Activate) (Be­
arbeiten -> Aktivieren).

Wenn kein weiterer Konflikt besteht, können Sie alle
Geräte neu konfigurieren (File->Reconfigure All (Da­
tei -> Alle neu konfigurieren) oder ).
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- Noch eine weitere Möglichkeit besteht darin, eine
vorbereitete Konfigurationsdatei  (File/Open) (Da­
tei/Öffnen) zu öffnen. Vergewissern Sie sich da­
nach durch eine entsprechende Prüfung, dass die
installierten Geräte und die Konfigurationsdatei mit­
einander übereinstimmen (File/Check Document)
(Datei/Dokument prüfen). Ein Prüfbericht wird
erzeugt:
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- Führen Sie, sofern erforderlich, eine erneute Konfi­
guration durch. Wählen Sie dazu File->Reconfi­
gure All (Datei -> Alle neu konfigurieren) aus.
Alternativ können Sie die Konfiguration eines ein­
zelnen Gerätes schreiben, indem Sie das entspre­
chende Dialogfeld für die Gerätekonfiguration öff­
nen und die Schaltfläche Write to device (In Gerät
schreiben) auswählen.
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7. Damit ist die Konfiguration abgeschlossen.

Es empfiehlt sich, diese zur weiteren Verwendung als
Referenzdokument in eine neue Konfigurationsdatei
zu schreiben (File->Save as) (Datei -> Speichern un­
ter).

8. Nun sollten alle Geräte am CAN-Bus einwandfrei
arbeiten.

Überprüfen Sie die LEDs an den MC1609-Geräten:
Die grüne LED muss EINGESCHALTET sein, die rote
LED muss AUSGESCHALTET sein.

Wenn eine rote LED an einem oder mehreren Gerä­
ten eingeschaltet ist, überprüfen Sie die Konfiguration
erneut. Wenn Geräte anderer Hersteller an den CAN-
Bus angeschlossen sind, vergewissern Sie sich, dass
alle CAN-Identifier jeweils nur von einem Gerät
verwendet werden!
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5 Anschlüsse

Alle Anschlüsse sind an der Vorderseite des MC1609
angeordnet:

� 16 Anschlüsse für Thermoelemente

� 2 LEMO-Anschlüsse für CAN und Stromversorgung
(auf der rechten Seite)

Informationen über den Status der LEDs finden Sie in

Kapitel 9.1 „Anzeige-LEDs“.

VORSICHT

Maßgeblich für die Wahl dieser Anschlusstypen für CAN
und Thermoelemente war ihre verbreitete Nutzung im
Markt. Die Standardversion von MC1609 ist mit gekap­
selten Anschlussgehäusen ausgestattet, um den
IP6x-Schutz des Gerätes sicherzustellen.

Die Kontakte von Steckverbindern und Steckern
(Thermoelement-Kabel) sind jedoch nicht 100 % was­
serdicht. HBM bietet daher ein Wartungspaket für den
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regelmäßigen Kundendienst an (siehe Kapitel 2.7

„Wartung und Kalibrierung“).

Folgende Anschlusstypen sind verfügbar:

5.1 Thermoelement-Eingänge

Das MC1609-Gerät stellt 16 Eingangskanäle für NiCr­Ni-
Sensoren (Typ K) bereit. Die Kanäle sind untereinander
sowie gegenüber der CAN-Schnittstelle und der Strom­
versorgung vollständig galvanisch getrennt.

Der obere Kontakt (in der Nähe der Kanalnummern
1…16) ist etwas kleiner als der andere Kontakt.
Schließen Sie das „NiCr“-Signal an diesen Kontakt an.
Der untere Kontakt (an der MC1609-Beschriftung)
transportiert das „Ni“-Signal.
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5.2 eDAQ (Datenerfassungssystem)

Die Verbindung zwischen dem eDAQ-System von HBM
und dem MC1609 wird mit Hilfe eines Spezialkabels mit
einem LEMO-CAN-/Stromversorgungsanschluss (Ste­
cker) auf der einen Seite und einem Anschluss (Stecker)
des Typs SoMat M8 Pigtails (mit Anschlussdrähten) auf
der anderen Seite hergestellt.

Die Stromversorgung des MC1609 wird bereits vom
eDAQ-System bereitgestellt, daher wird für eine einzelne
Messkette keine externe Versorgung benötigt. Bei meh­
reren Ketten muss ein weiteres Spezialkabel verwendet
werden. Weitere Informationen finden Sie in Kapitel 6,

„Kabel“.

Typ von SoMat M8-Buchse / Anschlussdrähten:
1­KAB421­2

Kontakt-
Nr.

Signal Beschreibung

1 SWC –

2 CAN_H CAN-High-Signal

3 AGnd Masse der Stromversorgung, CAN-
Masse

4 nicht verbunden

5 Power + Stromversorgung, Pluspol

6 CAN_L CAN-Low-Signal

Tab. 5.1 Kontaktbelegung

(Ansicht
an Vorder‐
seite des
Moduls)1 2

3

4

5 6
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5.3 CAN / Stromversorgung

MC1609 verwendet einen kombinierten Anschluss für
Stromversorgung und CAN. Es gibt zwei Anschlüsse
(Buchsen) für abgehende und ankommende Kabel. Dies
ermöglicht eine einfache Verdrahtung mit nur einem
dünnen Kabel zwischen mehreren MC1609-Geräten.
Am Ende einer solchen Kette wird ein CAN-Abschluss­
widerstand in den verbleibenden Anschluss eingesetzt.

Für Stromversorgungsanschluss und Verkettungen zwi­
schen Geräten steht eine große Auswahl an Kabeln in
unterschiedlichen Längen zur Verfügung. Weitere In­
formationen finden Sie in Kapitel 6 „Kabel“.

LEMO-Typ: 1­KAB292­2

Kontakt-
Nr.

Signal Beschreibung

1 Power + Stromversorgung, Pluspol

2 Power GND Stromversorgung, Masse

3 CAN_H CAN-High-Signal

4 CAN_L CAN-Low-Signal

5 CAN_GND CAN-Masse

Gehäuse Schirm Kabelabschirmung

Hinweis

Verwenden Sie für den CAN-Anschluss nur Originalkabel

von HBM (siehe Kapitel 6 „Kabel“).

(Ansicht an
Vorderseite
des Moduls)

2

3 4

5

1
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Hinweis

Beide Anschlüsse haben identische Anschlusskontakte.
Die Signale (CAN-Bus, Versorgung) sind direkt zwischen
den beiden Anschlüssen verbunden.
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6 Kabel

HBM bietet ein komplettes Sortiment optimierter
MC1609-Kabel.

Die Vorteile von HBM-Originalkabeln für MC1609:

� verlustarme Stromversorgungsleitungen

� geschirmte, verdrillte CAN-Doppelleitungen

� temperaturbeständig bis +150 °C

� 100 % nach der Produktion getestet

Hinweis

Es wird nachdrücklich empfohlen, nur HBM-Originalkabel
zu verwenden!

6.1 Anschluss zwischen zwei Geräten

6.1.1 MC1609-Anschlusskabel (1-KAB291-2/5/10)

ÓÓÓ
ÓÓÓ

ÓÓÓÓ
ÓÓÓÓ

1-KAB291-2

(Stecker) (Stecker)

Verwendung: Anschluss (Stromversorgung, CAN) zwischen
MC1609-Geräten in einer in Reihe verketteten Struktur

Länge: Erhältlich sind verschiedene Kabellängen (2 m, 5 m,
10 m)
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Anschluss: Vom CAN-Anschluss des einen Geräts zum CAN-An­
schluss eines anderen Geräts; Informationen zu Kupp­
lungsverbindungen von zwei Anschlusskabeln siehe un­

ter 6.1.2 „MC1609-Kabelkupplung“. Hierbei ist zu
beachten, dass die Verwendung eines Kabels in der
passenden Länge eine bessere Lösung bietet, als meh­
rere Kabel zusammenzukuppeln.

Artikel-Nr. Beschreibung

1-KAB291-2 SomatCR-Netzwerkkabel (2 m)

1-KAB291-5 SomatCR-Netzwerkkabel (5 m)

1-KAB291-10 SomatCR-Netzwerkkabel (10 m)

1-KAB292-2 SomatCR eDAQ/CR-Kabel (2,5 m)

1-KAB421-2 SomatCR Stromvers./CR-Kabel (2,5 m)

1-CONA1011 Abschluss

6.1.2 MC1609-Kabelkupplung

Auf Anfrage erhältlich.

ÓÓÓÓ
ÓÓÓÓ
ÓÓÓÓ

ÓÓÓÓ
ÓÓÓÓ
ÓÓÓÓ

ANFRAGE

(Buchse) (Buchse)

Verwendung: Koppeln von zwei Anschlusskabeln, um eine größere
Kabellänge zu erhalten.

Anschluss: Zwischen MC1609-Anschlusskabeln
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6.1.3 MC1609-Anschlusskabel mit
Stromversorgung (1­KAB423­2)

ÔÔÔ
ÔÔÔ

ÔÔÔ
ÔÔÔ

CAN & STROMV.

150 cm 100 cm

nur CAN

(Stecker)

300 cm

(Stecker)

1-KAB423-2

Verwendung: Stromversorgungsanschluss aller Geräte, die mit dem
Plus-Anschluss der Kette (Stromversorgung, CAN) zwi­
schen zwei MC1609-Geräten in der verketteten Struktur
verbunden sind.

Länge: Stromversorgungskabel 3,0 m
Geräteanschlusskabel 2,5 m

Anschluss: Roter Bananenstecker für positive Versorgungsspannung
(PLUS), schwarzer Bananenstecker für negative Versor­
gungsspannung (MINUS). Weitere Informationen über
den zulässigen Spannungsbereich 
finden Sie in Kapitel 10.1 „Stromversorgung“.

LEMO-Anschlüsse: Zum Verbinden eines CAN-An­
schlusses eines Geräts mit dem CAN-Anschluss eines
anderen.

Die Versorgung wird nur an den linken LEMO-Anschluss
(Stecker) angeschlossen (CAN & POWER (CAN & VER­
SORGUNG; durch Etikett gekennzeichnet). Der rechte
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LEMO-Anschluss (Stecker) transportiert nur die CAN-Si­
gnale.

Hinweis

Achten Sie darauf, dass Sie jeweils nur EINEN AN­
SCHLUSS MIT STROMVERSORGUNG an ein Gerät
anschließen. (Der Anschluss mit dem Etikett darf nur ein­
mal angeschlossen werden.)

Artikel-Nr. Beschreibung

1-KAB423-2 Stromversorgungs-Breakoutkabel für
SomatCR an eDAQ

Optionales Kabel für die Stromversorgung von einem
externen Gerät zum MC1609-Gerät und Turck-Anschluss
an eDAQ-CAN-Modul:

ÔÔ
ÔÔ

ÔÔÔ
ÔÔÔ

CAN & STROMV.

150 cm 100 cm

nur CAN

(Buchse)

300 cm

(Stecker)

1-KAB421-2

Artikel-Nr. Beschreibung

1-KAB421-2 Stromversorgungs-Breakoutkabel für
SomatCR an eDAQ-CAN-Modul
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6.2 Anschluss an CAN-Systeme

6.2.1 MC1609-Schnittstellenkabel mit
Stromversorgung (1­KAB292­2)

ÔÔÔ
ÔÔÔ

ÔÔ
ÔÔ

ÔÔ
ÔÔ
ÔÔ
ÔÔ

250 cm

1-KAB292-2

Verwendung: Stromversorgungsanschluss für das erste MC1609 von
miteinander verketteten Geräten an einem CAN-Bus zum
Anschluss an ein eDAQ-System mit Somat-M8-An­
schluss von der eCom-Schnittstelle.

Länge: Erhältliche Kabellänge:
1­KAB292­2 2,5 m

Anschluss: SoMat-M8-Anschluss mit Ausgangskontakten (Kontakt
1: SWC, Kontakt 2: CAN_H, Kontakt 3: AGnd, Kon­
takt 5: Stromversorgung und Kontakt 6: CAN_L; siehe

Kapitel 5.2 „eDAQ (Datenerfassungssystem)“)

LEMO-Anschluss an das erste MC1609-Gerät in der
Kette

Artikel-Nr. Beschreibung

1-KAB292-2 MC1609 CAN-Stromversorgung von 2,0 m
mit M8 und LEMO
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6.2.2 CAN-Abschlussstecker (1-CONA1011)

ÖÖÖÖ
ÖÖÖÖ

Verwendung: CAN-Busabschluss am Ende einer Kette.

Anschluss: Wird in den verbleibenden Anschluss des letzten
MC1609-Geräts in der Kette eingesetzt.

Artikel-Nr. Beschreibung

1-CONA1011 MC1609 CAN-Abschlussstecker
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7 Installation

7.1 Hinweise zur Stromversorgung

MC1609-Geräte von HBM sind energiesparend konzi­
piert und kommen mit einer Leistungsaufnahme von
2 Watt aus (typischer Wert). In Kombination mit dem
HBM-Originalkabel (sehr geringer Spannungsabfall
in den Stromversorgungsleitungen) und der so klein
wie möglich gehaltenen Gerätegeometrie ist in den
meisten Fällen eine EINFACHE, DIREKTE UND UN­
KOMPLIZIERTE INSTALLATION möglich.

Für die Wahl der Stromversorgungsstrategie sind
folgende Parameter relevant:

� Minimale Versorgungsspannung
Dies ist der Minimalwert der Spannung, die von der
Stromversorgung bereitgestellt wird. In Automo­
bilanwendungen ist dies normalerweise das Bordnetz
des Fahrzeugs (z. B. „12 V“ bei Personenwagen).
Beachten Sie, dass es auf den minimalen Wert an­
kommt. In einem „12 V“-System kann dieser Wert
beim Anlassen auf bis zu 8 V absinken (mehrere
Millisekunden lang).

� Anzahl der MC1609-Geräte
Jedes Gerät benötigt für seinen Betrieb elektrischen
Strom (typischer Wert 2 W, siehe technische Daten in

Kapitel 10.1 „Stromversorgung“). Beim Einschalten
wird kurzzeitig ein Einschaltstrom gezogen, der den
durchschnittlichen Betriebsstrom übersteigen kann.
Die Stromversorgung muss in der Lage sein, ausrei­
chend Strom für alle angeschlossenen Geräte zu
liefern.
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� Kabellänge
Der Widerstand der Anschlusskabel verursacht einen
Spannungsverlust entlang des Kabels, der von der
Kabellänge und dem durch das Kabel fließenden
Strom abhängt. Die Spannung am letzten Gerät in
einer Versorgungskette muss innerhalb des spezifi­
zierten Bereichs liegen (8 V oder höher, siehe

technische Daten in Kapitel 10.1 „Stromversorgung“).

Für typische Anwendungen empfiehlt HBM die
folgende Installation:

� Versorgungsspannung  12 V, Gesamtkabellänge 
10 m:
max. 7 Geräte pro Stromversorgung

� Versorgungsspannung  8 V, Gesamtkabellänge  
10 m:
max. 5 Geräte pro Stromversorgung
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7.2 Einfache Kette

CAN 00000

eDAQ

CAN 00000

CAN 00000

CAN 00000

1-CONA1011

1-KAB291-2/5/10

1-KAB291-2/5/10

1-KAB291-2/5/10

1-KAB292-2
1-KAB421-2 mit
Stromvers.

Computer mit CANcard
und Software SomatCR
Assistant

� Das Erfassungssystem (eDAQ) wird mit dem ersten
MC1609-Gerät über das integrierte Stromversor­
gungs- und CAN-Kommunikationskabel (1­KAB292­2)
verbunden. Das Kabel 1­KAB421­2 kann verwendet
werden, wenn eine externe Stromversorgung benötigt
wird, beispielsweise bei Verwendung eines CAN-
Smart-Moduls.

� Am Ende des CAN-Bus wird ein CAN-Abschlussste­
cker (1­CONA10111) in den verbleibenden CAN-An­
schluss eingesetzt.

� Das eDAQ-System versorgt den Beginn der Geräte­
kette. Je nach Anzahl der Geräte, Kabellänge und
minimalem Spannungswert der Stromversorgung
gelten gewisse Einschränkungen.
Weitere Informationen hierzu finden Sie in Kapitel 7.1

„Hinweise zur Stromversorgung“.
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7.3 Lange Kette mit zusätzlicher
Stromversorgung

CAN 00000

eDAQ

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

1-KAB291-2/5/10

1-KAB292-2 Computer mit CANcard und
Software SomatCR Assistant

1-KAB423-2

1-KAB291-2/5/10

1-KAB423-2

1-KAB291-2/5/10

1-CONA1011

1-KAB423-2

STROM-
VERSOR-
GUNG 2

STROM‐
VERSOR‐
GUNG 1
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� Dieses Beispiel zeigt eine komplexere Installation mit
drei Clustern, von denen jeder aus mehreren
MC1609-Geräten besteht.

� Alle Geräte sind an einen CAN-Bus angeschlossen.
Am Ende des CAN-Bus wird ein CAN-Abschlussste­
cker (1­CONA1011) in den verbleibenden CAN-An­
schluss eingesetzt.

� Jeder Cluster hat seine eigene Stromversorgung, um
Spannungsverluste entlang der Anschusskabel zu
minimieren.

� Bei Verwendung an anderen Geräten als dem HBM
eDAQ muss die erste Einheit an eine geeignete
Stromquelle angeschlossen werden. Dies kann mit
einem der folgenden MC1609-Kabel erreicht werden:
1­KAB292­2 (M8 an MC1609), 1­KAB422­2 (9-poliger
D­Sub-Anschluss an MC1609 ) oder 1­KAB296­2  (of­
fene Anschlussdrähte (Pigtail) an MC1609).

� Zwischen dem ersten und dem zweiten Cluster wird
ein MC1609-Anschlusskabel mit Stromversorgung
(Etikett) installiert. Dieses Kabel stellt eine direkte
Verbindung für die CAN-Bussignale zwischen den
Geräten her.
Die Stromversorgung erfolgt nur vorwärts in Richtung
des zweiten Clusters. Es gibt keine Verbindung der
Stromleitungen zwischen den beiden LEMO-Steckern
des Kabels.
Die beiden Bananenstecker-Kabel werden an den mit
dem weißen Etikett gekennzeichneten LEMO-Stecker
angeschlossen.
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Hinweis

Achten Sie darauf, dass das MC1609-Anschlusskabel
mit Stromversorgung (Etikett) korrekt installiert wird ­ der
gekennzeichnete LEMO-Stecker muss in einen der CAN-
Anschlüsse des ersten Geräts im zweiten Cluster einge­
setzt werden.

� Der letzte Cluster verfügt über eine eigene Stromver­
sorgung mit einem MC1609-Anschlusskabel mit
Stromversorgung (Etikett), ähnlich wie der zweite
Cluster.

Weitere Informationen zur Wahl einer geeigneten Strom­
versorgungsstrategie finden Sie im vorhergehenden Ka­

pitel 7.1 „Hinweise zur Stromversorgung“.
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8 Konfiguration

MC1609 kann für die Verwendung kundenspezifischer
Parameter für die CAN-Übertragung konfiguriert werden.

Die gesamte Konfiguration erfolgt über die CAN-Schnitt­
stelle von MC1609. Dafür wird ein leistungsfähiges CAN-
Konfigurationsprotokoll verwendet, das eine komfortable
Konfiguration des MC1609 ermöglicht.

Die Konfiguration wird mit der Windows-Anwendung
SomatCR Assistant (SomatCR­Assistant.EXE) durchge­
führt, die auf einem Datenträger zusammen mit allen Ge­
räten ausgeliefert wird.
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Weitere Informationen zur Konfiguration finden Sie in der
Online-Hilfe der Anwendung.
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Wichtige Hinweise für die Konfiguration

Hinweis

Während der Konfiguration muss der Betrieb mit der kor­
rekten CAN-Bitrate erfolgen, insbesondere, wenn Geräte
anderer Hersteller an den CAN-Bus angeschlossen
werden.

Hinweis

Wenn während der Konfiguration Probleme auftreten,
trennen Sie die Verbindung zu allen Fremdgeräten.
Wenn das Problem weiterhin besteht, wenden Sie sich
an den Support von HBM (siehe Kapitel 2.9

„Updates und Kontakt“).

8.1 Systemvoraussetzungen

Standard-PC mit Microsoft Windows-Betriebssystem
Empfohlen: AMD Athlon/Pentium IV oder besser,
Windows XP, Vista und 7 (Vista/7 sollten im Administra­
tor-Modus installiert sein)

Eines/einer der folgenden CAN-Geräte/Treiber von
Drittanbietern sollte erfolgreich in dem System installiert
werden:

Vector CAN (www.vector­informatik.de) 1

API: XL-Treiberbibliothek 7.4

1) Getestete Geräte: Vector CANCard

Plattform

CAN-Schnittstelle
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vxlapi.dll  7.4.50.0
vcanxl.sys / vcasexl.sys  7.3.18

Kvaser CAN (www.kvaser.se) 2

API: CANLIB 4.0

canlib32.dll 6.09.4495
kcane.sys 6.09.4495

dSpace Generic CAN (www.dspace.de) 3

nur DCI­CAN1-Adapter

CanApi2.dll 2.47.1
DSCanApi10.dll 2.3.0.45
PCAN_USB.SYS 2.48.14.0

PEAK (www.peak­system.com) 4

nur PCAN­USB-Adapter

Pcan_usb.dll 1.54.0
PCAN_USB_SYS 2.49.8.4514

Softing (www.softing.com) 5

API CAN Layer2 (V5.11)

canL2.dll 5.11.0.1
canusbw.sys 6.0.2.63

National Instruments (www.ni.com) 6

API: NI­CAN 2.5.2

2) Getestetes Gerät: Kvaser USBcan2
3) Verwendet den PCAN-Treiber und dSPACE API­DLL, die

zusammen mit dSPACE CalDesk installiert werden.
Getestetes Gerät: dSpaceCallDesk 2.0

4) PEAK: Derzeit wird PEAK Lite – API unterstützt. PEAK CANAPI2
wird noch nicht unterstützt.
Getestetes Gerät: PCAN­USB mit PCAN Light API

5) Getestetes Gerät: Softing CANusb
6) Getestetes Gerät: NI PCMCIA­CAN Series 2



Konfiguration

SomatCR A3686-1.1  HBM: public 59

nican.dll 2.5.0.49158
nicanpkw.sys 2.5.1f0

IXXAT (www.ixxat.com) 7

API: NI­CAN 2.5.2

vcinpl.dll 1.0.0.1784
vci109w3.sys 3.1.4.1784

Unterstützung für andere CAN-Geräte kann auf Anfrage
bereitgestellt werden.

8.2 Hinweise zur Nutzung

Die Standard-Werkseinstellung für MC1609 ist wie folgt
(Protokoll CANopen):
CAN-Bitrate 500 000 Bit/s
Abtastpunkt 66 %
Identifier-Länge 11­Bit (Standard­CAN)
Note-ID 1
CAN-Identifier 0x0180 + NODE_ID, 0x0280 + 

NODE_ID,
0x0380 + NODE_ID und 0x0480 +
NODE_ID

Datenformat INTEL
Auflösung 0,1 °C
Übertragungsrate 100 ms

Es wird nachdrücklich empfohlen, die Basiskonfiguration
(CAN-Bitrate, Identifier ...) für jedes Gerät getrennt
durchzuführen (siehe Kapitel 4, insbesondere 4.1

„In Büro oder Labor“).

7) Getestetes Gerät: IXXAT USB­to­CAN compact
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9 Betrieb

9.1 Anzeige-LEDs

An der Vorderseite des MC1609 zeigt eine LED (Licht-
emittierende Diode) in der Nähe der CAN-Anschlüsse
den Betriebsstatus an (siehe CANopen-Anzeigespezifika­
tion DR­303­3).

Die LED kann einen der folgenden unterschiedlichen Zu­
stände anzeigen:

AUS Die LED ist ausgeschaltet.

EIN Die LED ist eingeschaltet.

DOPPELTES
AUFLEUCHTEN

Die LED wird zwei Mal EIN geschaltet
(200 ms), die zweite AUS-Schaltung
dauert 1000 ms.

EINZELNES AUF­
LEUCHTEN

Die LED ist 200 ms lang EIN geschaltet
und 1000 ms lang AUS geschaltet.

SCHNELLES
BLINKEN

Die LED blinkt (200 ms EIN, 200 ms
AUS und so weiter).

LANGSAMES
BLINKEN

Die LED blinkt (1 Sekunde EIN, 1 Se­
kunde AUS und so weiter).

Während des Normalbetriebs (z. B. nach dem Einschal­
ten) ist die grüne LED „Stromversorgung“ EIN und die

rote LED „Fehler“ ist AUS geschaltet.

Außerdem verfügen die Module über eine Anzeige für
jeden Kanal. Einzelheiten siehe unter 9.1.2

„Kanalanzeige-LEDs“.
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9.1.1 Beschreibung

AUS Keine Stromversorgung

EIN (grün) Das Gerät ist im BETRIEBSBEREITEN
Zustand.

EINZELNES AUF­
LEUCHTEN (grün)

Das Gerät ist im GESTOPPTEN Zu­
stand.

SCHNELLES
BLINKEN (grün)

Das Gerät BEREITET DIE BETRIEBS­
BEREITSCHAFT VOR.

AUS (rot) Das Gerät ist im Arbeitszustand.

EIN (rot) Bei dem Gerät ist der Bus ausgeschaltet
(Busausschaltung wird vom CAN-Con­
troller gehandhabt).

DOPPELTES
AUFLEUCHTEN
(rot)

Ein Ereignis des Typs „Event“ oder „He­

artbeart“ ist eingetreten.

SCHNELLES
BLINKEN (grün/
rot)

Download der Firmware ist im Gange

9.1.2 Kanalanzeige-LEDs

AUS Ein Thermoelement ist angeschlossen.

EIN (rot) Es ist kein Thermoelement angeschlos­
sen (Sensorbruch).
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9.2 CAN-Kommunikation

Im Normalbetrieb (siehe Kapitel 9.1 „Anzeige-LEDs“)
überträgt das MC1609 in regelmäßigen Abständen CAN-
Nachrichten, die die gemessenen Temperaturen enthal­
ten.

Die CAN-Bus-Parameter (z. B. Bitrate) und auch die
CAN-Nachrichten (z. B. Identifier, Übertragungsrate)
können konfiguriert werden. Weitere Informationen finden

Sie in Kapitel  8 „Konfiguration“.

9.2.1 Nachrichten

ID Rate DLC
DATA

0
DATA

1
DATA

2
DATA

3
DATA

4
DATA

5
DATA

6
DATA

7

0x0181 rate 8
CH1 CH2 CH3 CH4

0x0182 rate 8
CH5 CH6 CH7 CH8

0x0183 rate 8
CH9 CH10 CH11 CH12

0x0184 rate 8
CH13 CH14 CH15 CH16

Der CAN-Identifier (ID) der ersten CAN-Nachricht kann
mit dem „SomatCR Assistant“ konfiguriert werden (siehe

Kapitel  8 „Konfiguration“).

Die Übertragungsrate rate der CAN-Nachrichten, die die
Daten von Kanal 1 bis 16 (CH1…CH16) enthalten, kann
konfiguriert werden (5 ms, 10 ms, 20 ms, 50 ms, 100 ms,
200 ms, 500 ms, 1000 ms, 2000 ms oder 5000 ms).
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Eine Beschreibung der DATAx-Bytes in den Nachrichten
finden Sie in 9.2.2 „Signale“.

9.2.2 Signale

CH1 … CH16

Beschreibung: Temperaturwert des Thermoelement-Eingangs

Auflösung: 0,1 °C

Bereich: ­100,0 °C … +1372,0 °C bzw. 0xFC18 … 0x3598

Sensorbruch: Sonderwert, wenn kein Thermoelement am Eingang
0x8000 erkannt wird.

Format: INTEL (niederwertigstes Bit (LSB) zuerst)
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10 Technische Daten

Wie bei vielen Elektronikgeräten wird auch beim MC1609
die Messgenauigkeit sowohl durch die Installation als
auch durch die Bedingungen bestimmt, unter denen das
Gerät genutzt wird.

Wenn das Gerät beispielsweise bei Umgebungstempera­
turen zwischen
~ ­10 °C und ~ +50 °C für Messungen bis 1100 °C
verwendet wird, ist die Messung auf ≤ 0,5 °C genau,
während bei einer Umgebungstemperatur unter ­30 °C
oder über +85 °C diese Genauigkeit um ungefähr 
≤ 0,5 °C pro 15 °C (in beide Richtungen) abnimmt, wenn
die Messeingänge über 1150 °C steigen.

Wichtig

Die obigen Genauigkeitsangaben basieren auf der
Verwendung von Kabeln von ≤ 3 m Länge; siehe Kapi­
tel 2.4.

10.1 Stromversorgung

Spannungsbereich ca. 8 V bis 42 V DC

Leistungsaufnahme typischer Wert 2,0 W (16 Kanäle)

Anschlüsse LEMO (Typ 0B) für HBM-Kabel (siehe Kapitel 6 „Kabel“)

Schutzsicherung Für eine nicht abgesicherte Stromversorgung wird eine
externe Schutzsicherung empfohlen. Die Sicherung muss
nach maximal 120 s bei 4,76 A öffnen. Geeignet ist zum Bei­

spiel eine ATO-Standardsicherung mit „2A“.
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10.2 Eingänge

Kanäle 16 Eingangskanäle

Sensor NiCr­Ni-Thermoelemente (Typ K)
Fe-CuNi-Thermoelemente (Typ J)
Cu-CuNi-Thermoelemente (Typ T)

Anschlüsse Miniatur-Thermoanschlüsse

Messbereich Typ K: ­100 °C bis +1372 °C
Typ J: -100 °C to +1200 °C
Typ T: -100 °C to +400 °C

Messauflösung 16 Bit

Kleinste Messeinheit 0.1 °C

Messgenauigkeit Siehe Diagramm (am Ende dieses Abschnitts). Weitere In­
formationen erhalten Sie bei dem für Sie zuständigen Support
von HBM.

Interne Abtastrate 1000 Hz

Messrate 1/5 Hz, 1/2 Hz, 1 Hz, 2 Hz, 5 Hz, 10 Hz, 20 Hz, 50 Hz, 100 Hz,
200 Hz

Eingangsfilter Tiefpassfilter mit digitaler Filterung

Merkmale Erkennung von gebrochener Sensorverbindung
Getrennte Vergleichsstelle für jeden Kanal

Eingangsschutz ±60 V permanent, Schutz vor elektrostatischer Entladung
(ESD)

Isolationsspannung 500 V DC zwischen Eingangskanälen
500 V DC zwischen Eingangskanal und Stromversorgung
500 V DC zwischen Eingangskanal und CAN
500 V DC zwischen Stromversorgung und CAN
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10.3 CAN-Schnittstelle

CAN-Spezifikation CANopen (EN 50325­4)

Physikalische Schicht Hochgeschwindigkeits­CAN (ISO 11898)

Bitrate 125 kBit/s, 250 kBit/s, 500 kBit/s (Standard), 1 MBit/s

Anschlüsse LEMO (Typ 0B) für HBM-Kabel (siehe Kapitel 6 „Kabel“)

10.4 Konfiguration

Schnittstelle Über CAN-Bus

Protokoll Kompatibel mit allen anderen MC1609-Geräten

Speicher Nichtflüchtiger Speicher im Gerät

Nutzung Windows-Anwendung SomatCR Assistant
(SomatCR­Assistant.EXE)

10.5 Abmessungen

Maße (B x H x T) Ca. 200 x 35 x 50 mm³ (77/8" x 13/8" x 2")

Gewicht Ca. 500 g (ca. 173/5 oz.)
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Umgebungstemperatur °C

M
es

st
em

pe
ra

tu
r 

°C
Abb. 10.1 Genauigkeitsmatrix
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10.6 Montage

Montagelöcher:

Schraubengröße: M4 x 10 mm

X

YEntlüftungsöffnung

Rückansicht

X = 194 mm Y = 29 mm

VORSICHT

Entlüftungsöffnung nicht abdecken! Nicht darin herum­
stochern! Siehe Kapitel 2.5, 2.6, 2.9 !!

Detaillierte Zeichnungen fordern Sie bitte bei HBM an.
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10.7 Umgebungsbedingungen

Standardversion

Betriebstemperatur ­40 °C bis +120 °C 
(ca. ­40 °F bis +250 °F)

Feuchtigkeit 5 % bis 95 % (nicht kondensierend)

Höhe 0 m bis 2000 m ü. NN

Schutzart IP65

Verschmutzungsgrad 3 (nach IEC 60664-1)
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11 Fehlerbehebung

Lesen Sie als ersten Schritt die nachfolgenden, fett ge­
druckten Themenüberschriften. Vielleicht ist die Lösung
Ihres Problems dort schnell zu finden.

Die Stromversorgungs-LED leuchtet überhaupt
nicht.

Vergewissern Sie sich, dass Ihre Versorgungsspannung
innerhalb des spezifizierten Bereichs liegt (siehe Kapi­
tel 10.1 „Stromversorgung“).

Verwenden Sie ein geeignetes Kabel für die Stromver­
sorgung 
(siehe Kapitel 6 „Kabel“).

Eine weitere Ursache könnte ein Hardware-Fehler des
Geräts sein. Wenden Sie sich an HBM (siehe Kapitel 2.9

„Updates und Kontakt“).

Ich benötigte Unterstützung von HBM.

Wenn Sie Unterstützung benötigen, füllen Sie unser Sup­
port-Formular im Internet aus (siehe Kapitel 2.9
„Updates und Kontakt“).
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1 Introduction

Les appareils MC1609 de HBM visent à fournir des
possibilités d'extension économiques plug&play permet­
tant de perfectionner le système d'acquisition de don­
nées eDAQ Somat proposé par HBM. Mobile, il est aisé­
ment utilisable avec d'autres appareils compatibles, tels
que ceux des gammes QuantumX, MGC, etc.,
conformes à la norme CAN Open.

Il est destiné à une installation ‘décentralisée', ceci lui
permettant d'être fixé relativement aisément à un
support, tout en étant conforme aux exigences
thermiques liées à son positionnement. Son débit permet
le raccordement de nombreux appareils, en vue de
l'obtention de chaînes de mesure de plus grande taille.

Caractéristiques (MC1609)

� 16 entrées dans un boîtier compact pour thermo­
couples

- Type K (NiCr-Ni): de -100,0 °C à +1372,0 °C

- Type J (Fe-CuNi): de -100,0 °C à +1200,0 °C

- Type T (Cu-CuNi): de -100,0 °C à +400,0 °C

� Haute précision (filtre passe-bas/numérique, linéari­
sation, compensation en température, …)

� Vitesse d'échantillonnage interne de 1000 Hz par voie

� Vitesse de mesure de 0,5 Hz à 200 Hz pour l'en­
semble des voies (configurable par l'utilisateur)

� Détection de thermocouples manquants ou défec­
tueux

� Protection contre les surtensions ±60 V (continue) au
niveau des entrées capteurs
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� Traçabilité de l'étalonnage vis-à-vis de la norme
nationale incluse

� Affichage à LED de voies

� Interface CAN à grande vitesse (500 kbps par défaut,
1 Mbps maxi.)

� Configuration de tous les paramètres CAN (CAN
standard, point d'échantillonnage, identifiant, …)

� Configuration système interne par modem grâce au
logiciel SomatCR Assistant

� Deux connecteurs système CAN LEMO identiques
(branchés en parallèle) en vue d'une installation aisée
du bus CAN et de l'alimentation

� Plage d'alimentation électrique d'env. +8 V …+42 V,
idéale pour tous les systèmes d'alimentation em­
barquée standards 12 / 24 / 42 V

� Faible consommation d'énergie (typ. 2 W)

� Tension d'isolement de 500 V entre les voies,
l'interface CAN et l'alimentation électrique

� Boîtier durci et compact

� Simple d'emploi, reportez-vous au chapitre 4
"Pour commencer" pour des informations
supplémentaires

Environnement de fonctionnement

� Température de fonctionnement : ­40 °C à +120 °C

� Classe de protection : IP65
Degré de pollution 3 (selon IEC 60664­1)

� Pour un fonctionnement dans le compartiment moteur

Configuration

� Configuration aisée via CAN
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� Application Windows conviviale, intégrant une
auto­détection et une auto­configuration

� Base de données de signaux compatible CANdb pour
tous les appareils raccordés
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2 Informations importantes

2.1 Symboles

Note

Ce symbole signale des instructions, dont il convient de
tenir compte en totalité, afin d'éviter blessures, risques
ou préjudices matériels !

AVERTISSEMENT

Ce symbole signale des instructions, dont il convient de
tenir compte en totalité, afin d'éviter blessures, risques
ou préjudices matériels !

Important

Ce symbole signale des informations devant être toutes
comprises pour bénéficier de l'ensemble des avantages
apportés par le système.

2.2 Déclin de responsabilité

Sous réserve de modifications techniques du matériel,
logiciel et de la documentation sans avis préalable.

La société HBM ne saurait être tenue responsable de
dommages directs ou indirects quelconques résultant de
l'utilisation d'appareils ou des logiciels associés, ainsi que
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d'erreurs figurant dans la documentation ou d'omissions
ayant pu être faites dans cette dernière.

Le matériel, les logiciels et la documentation sont fournis
"en l'état" et leur fonctionnement dans le système du
client final ne fait l'objet d'aucune garantie.

ATTENTION

La protection risque d'être altérée si l'appareil n'est pas
utilisé de la manière indiquée.

ATTENTION

Toujours utiliser des pièces agrées par HBM, tels que les
câbles, les kits de montage, etc.

2.3 Avertissement relatif au bus CAN

Il est recommandé de raccorder les équipements d'acqui­
sition de données, tels que le MC1609, à un bus CAN
séparé (bus de mesure). Ceci permet d'obtenir des
performances de mesure maximales et réduit à un mini­
mum les risques d'anomalie de fonctionnement d'un sys­
tème de bus CAN existant.

Veuillez faire attention, lors du raccordement de périphé­
riques tiers à un bus de mesure comportant des
appareils MC1609 de HBM. Veillez à utiliser des para­
mètres de configuration compatibles pour tous les
appareils (le même débit CAN, des identifiants CAN dif­
férents, etc.)
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AVERTISSEMENT

L'utilisation d'appareils MC1609 risque d'exposer à des
dangers !
Elle est réservée à du personnel ayant été formé à cet
effet !

Le raccordement d'un appareil MC1609 à un bus sys­
tème CAN existant, tel qu'un système automobile ou
d'automatisation) risque d'altérer le comportement du bus
CAN, ceci risquant de causer des préjudices corporels ou
matériels graves. L'utilisation d'appareils MC1609 est
réservée à des personnes s'étant familiarisées avec leur
fonctionnement et leur manutention.

Afin d'éviter tout risque, respectez les règles sui­
vantes :

� Lisez attentivement le présent manuel, afin de le com­
prendre.

� Utilisez des configurations correctes (notamment les
paramètres CAN).

� Lors d'un raccordement à votre système de bus CAN,
prenez toutes les précautions en matière de sécurité.

HBM DÉCLINE TOUTE RESPONSABILITÉ en cas
d'erreurs, de dommages ou de préjudices corporels
subis lors d'une utilisation quelconque ou d'une ma­
nutention non autorisée, impropre ou incorrecte
d'appareils MC1609.

Pour tout renseignement, contactez immédiatement
HBM, AVANT de commencer à utiliser des appareils
MC1609. Voir le paragraphe 2.9 pour savoir comment
contacter HBM.
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2.4 Informations en matière de CEM

HBM déclare que le produit décrit dans le présent ma­
nuel est conforme aux exigences de la Directive euro­
péenne CEM 2004/108/CE, lors d'une utilisation avec
des câbles d'une longueur maximale de 3 m. Il n'est pas
conseillé d'utiliser le MC1609 avec des câbles de plus de
3 m. L'appareil pourrait alors dépasser les spécifications
concernant la compatibilité électromagnétique. Comme
l'appareil est conçu pour une installation 'localisée', cela
peut être aisément évité. Veuillez contacter votre support
local pour de plus amples informations.

Note

Les appareils MC1609 de HBM sont des produits de
classe A. En environnement résidentiel, ces produits
risquent d'entraîner des interférences radio. Dans un tel
cas, l'utilisateur peut être tenu de prendre les mesures
adéquates.

2.5 Manutention / précautions de
montage

Les appareils MC1609 sont dotés d'une mem­
brane GORE� essentielle à la régulation de pression et
d'humidité. Ceci est nécessaire pour faire face aux
températures ambiantes sujettes à des changements
rapides dans les véhicules.

Il s'agit d'une méthode appropriée et communément utili­
sée.

Il est impératif que le petit trou d'aération du boîtier de
l'appareil soit ouvert et dégagé. Si ce n'est pas le cas, de
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la condensation risque de se former dans le boîtier et de
causer un endommagement irréversible de l'appareil !

De l'eau se trouvant au niveau du trou d'aération endom­
mage la membrane ! S'il est prévu d'installer l'appareil à
un endroit où de l'eau ou d'autres liquides risquent de
s'accumuler, installez l'appareil de sorte que le petit trou
d'aération du boîtier soit ouvert et dégagé et que les
liquides puissent s'évacuer. Les liquides stagnant au ni­
veau du trou d'aération risquent d'endommager la mem­
brane de manière irréversible. L'appareil ne possède
alors plus l'indice de protection IP65 ni les caracté­
ristiques associées.

ATTENTION

Ne pas couvrir ce trou. Une circulation d'air libre est
nécessaire !

ATTENTION

Ne pas insérer d'objets dans ce trou, car ceci détruirait la
membrane.
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ATTENTION

Ne dévisser aucune des vis en face avant. Ceci risque­
rait d'altérer la protection IP6x de l'appareil.

ATTENTION

S'assurer que le montage des appareils a été réalisé de
manière sûre afin d'éviter tout endommagement.

ATTENTION

Ne pas monter l'appareil avec les connecteurs orientés
vers le bas. Les connecteurs doivent se trouver sur un
côté ou sur le dessus de l'appareil.

ATTENTION

La position de montage doit être choisie de façon à ce
que les connecteurs soient aisément accessibles afin de
pouvoir déconnecter l'alimentation/le câble CAN faci­
lement.
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ATTENTION

Utilisé dans des environnements chauds (par ex. le com­
partiment moteur), la surface de l'appareil peut elle-aussi
devenir très chaude. Laissez l'appareil refroidir avant de
le manipuler ou utilisez une protection adéquate.

2.6 Sécurité

Tous les appareils MC1609 ont été conçus pour être
conformes aux normes de sécurité. Leur usinage est
supervisé par un système de gestion de la qualité
ISO9000.

ATTENTION

Ne pas ouvrir l'appareil. Les pièces qu'il contient sont
sans entretien.
Aucune transformation mécanique ou électrique ne doit
être réalisée sur l'appareil.
Veillez à ne pas perdre les vis en face avant.

Toute manutention non autorisée de l'appareil risque
d'altérer la protection IP6x !

Note

Préalablement au raccordement de tout câble, assurez-
vous que les signaux appliqués (alimentation électrique,
thermocouples) soient compris dans la plage autorisée
(reportez-vous au chapitre 10 "Fiche technique").
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Note

Une différence de potentiel électrique risque de se pro­
duire dans le véhicule via le blindage des câbles
d'interface des modules ! Ne montez les appareils que
sur des composants ayant un potentiel électrique iden­
tique ou isolez les appareils des composants.

ATTENTION

Pour éviter les incendies, utilisez un fusible de sécurité
dans l'alimentation électrique. Le fusible doit couper le
courant après 120 secondes maximum à 4,76 ampères.

Note

Assurez-vous que l'installation de l'appareil soit correcte.
N'utilisez l'appareil que dans l'environnement spécifié
(reportez-vous au chapitre 10 "Fiche technique").

Toutes les voies d'entrée sont dotées d'une protection
galvanique mutuelle ainsi que contre l'alimentation
électrique et CAN. Cette isolation fonctionnelle a été
conçue pour 500 V C.C. Une homologation de type avec
une tension d'essai de 500 V C.C. a été réalisée avec
succès.
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Important

L'isolation galvanique de 500 V C.C. est une isolation
fonctionnelle n'ayant pas été testée au cours d'un essai
de contrôle courant.
Donc, les appareils MC1609 de HBM ne doivent être utili­
sés que pour des mesures avec des tensions de 60 V
C.C. maxi.

La société HBM DÉCLINE TOUTE RESPONSABILITÉ
en cas d'une utilisation avec des tensions supérieures à
60 V C.C.

2.7 Maintenance & étalonnage

Tous les appareils MC1609 sont fournis avec un certificat
d'étalonnage établi par un laboratoire d'étalonnage
national.

Important

HBM recommande un étalonnage régulier tous les ans.

Suivant l'environnement de fonctionnement et le type de
connecteurs utilisé pour les thermocouples, les contacts
des connecteurs risquent d'être sujets à une usure ra­
pide. Le Pack de maintenance HBM (voir ci-après) en
option inclut le remplacement de tous les connecteurs de
l'appareil.

HBM propose un Pack de maintenance pour les
appareils MC1609 incluant l'étalonnage et d'autres avan­
tages. Pour des informations supplémentaires, veuillez
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contacter directement HBM
(reportez-vous à 2.9 "Mises à jour & contact").

Une maintenance régulière de l'appareil chez HBM une
fois par an est nécessaire pour prolonger le droit à la ga­
rantie de l'appareil.

2.8 Mise au rebut de produits usagés

Les produits de HBM ont été conçus et fabriqués à l'aide
de matériaux et composants haute qualité pouvant être
recyclés et réutilisés.

Lorsqu'un produit est accompagné d'un symbole re­
présentant une benne sur roues munie d'une croix, cela
signifie que ce produit est concerné par la Directive euro­
péenne 2002/96/CE. Veuillez vous informer des sys­
tèmes locaux de collecte séparée des produits
électriques et électroniques. Respectez la réglementation
locale et ne jetez pas les produits usagés aux ordures
ménagères. L'élimination correcte de vos produits
usagés permet de protéger l'environnement et la santé
publique.
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2.9 Mises à jour & contact

HBM propose un support technique pour ses produits
pendant toute la durée de vie de ces derniers. Des mises
à jour pour tous les composants (par ex. la documen­
tation, le logiciel de configuration, le firmware de
l'appareil, etc.) seront fournies lorsqu'elles seront
disponibles.

Nous vous conseillons fortement de vous rendre à la
page TELECHARGEMENT sous Support sur notre site
Internet environ une fois par mois, afin de rester à jour.

HBM, Inc.
19 Bartlett Street,
Marlborough, MA 01752
Tél. : +1 800­578­4260
Fax : +1 508­485­7480
E-mail ventes : info@usa.hbm.com
E-mail support :support@usa.hbm.com
Site : http://www.hbm.com

Web
français : http://www.hbm.com/fr/
anglais : http://www.hbm.com/

Support
français : http://www.hbm.com/fr/menu/support/
anglais : http://www.hbm.com/en/menu/support/

Téléchargements
français : http://www.hbm.com/fr/menu/support/

software­firmware­downloads/
anglais : http://www.hbm.com/en/menu/support/

software­firmware­downloads/

mailto:info@usa.hbm.com
mailto:support@usa.hbm.com
http://www.hbm.com
http://www.hbm.com/de/
http://www.hbm.com/
http://www.hbm.com/de/menu/support/
http://www.hbm.com/en/menu/support/
http://www.hbm.com/de/menu/support/software-firmware-downloads/
http://www.hbm.com/de/menu/support/software-firmware-downloads/
http://www.hbm.com/en/menu/support/software-firmware-downloads/
http://www.hbm.com/en/menu/support/software-firmware-downloads/
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3 Manutention

3.1 Montage

En raison de leur conception durcie et compacte, les
appareils MC1609 peuvent être montés quasiment
partout. Toutefois, on distingue certaines restrictions, afin
d'obtenir une performance et une durée de vie du produit
optimales.

Ne pas dépasser les limites ambiantes (température,
humidité, vibrations, etc.)

Utilisez les trous de vis disponibles en face arrière de
l'appareil.

Ne pas oublier d'appliquer un frein filet approprié, si
nécessaire (par ex. Loctite®).

Ne percez aucun trou supplémentaire dans le boîtier !
Contactez HBM (reportez-vous au paragraphe 2.9
"Mises à jour & contact") pour des informations
concernant les kits de montage des appareils.

En complément des trous de vis, les appareils MC1609
de la nouvelle génération prévoient 4 trous oblongs (2 de
chaque côté). Des éléments de fixation (par ex. des
serre-câbles) peuvent être introduits dans ces trous, afin
de permettre une fixation aisée.

Note

Ne pas laisser tomber l'appareil ! A l'issue d'une chute,
surtout sur le bord, le joint risque d'être endommagé !
Renvoyez l'appareil à HBM pour un contrôle.
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Note

Ne pas monter l'appareil avec les connecteurs orientés
vers le bas. Les connecteurs doivent se trouver sur un
côté ou sur le dessus de l'appareil.

Note

La position de montage doit être choisie de façon à ce
que les connecteurs soient aisément accessibles afin de
pouvoir déconnecter l'alimentation/le câble CAN faci­
lement.

3.2 Nettoyage

Débranchez tous les câbles du MC1609 avant de le net­
toyer.

Utilisez un tissu sec ou légèrement humidifié. Si des sa­
lissures devaient encore s'y trouver, vous pouvez utiliser
un peu de détergent doux.

Note

Ne jamais utiliser ni des solvants forts ni des abrasifs !
Aucun liquide ne doit pénétrer dans l'appareil ou ses
connecteurs !
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3.3 Accessoires

ATTENTION

Toujours utiliser des pièces HBM d'origine, tels que les
câbles, les kits de montage, etc.

Les pièces agrées par HBM ont été conçues et soigneu­
sement homologuées, afin de fournir un profit maximum
au client. Reportez-vous au chapitre 6 "Câbles" pour une
liste de tous les câbles disponibles. Veuillez contacter
HBM, si vous avez besoin d'un câble spécial en vue du
raccordement d'un appareil tiers au bus CAN.
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4 Pour commencer

4.1 Au bureau ou en laboratoire

1. Branchez l'appareil à la plate-forme de
configuration.

�

�

�

� MC1609 de HBM

� Câble d'interface CAN

� 16 thermocouples
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1

4

3

2

5

CAN 00000

CAN 00000

PC avec logiciel SomatCR
Assistant
(à noter : risque de
nécessiter une CANcard)

Inter‐
face

1-KAB292-2

1-CONA1011

1-KAB291-2

� MC1609 de HBM. Le système va tester et
configurer ces appareils.

� Câble d'interface HBM (LEMO vers eCOM M8 –
1­KAB292­2, le câble 1­KAB421­2 peut être utilisé
lorsqu'une alimentation est requise)

� PC avec CANcard sur lequel le logiciel SomatCR
Assistant de HBM a été installé.

� DAQ (QX/eDAQ) ou interface CAN
� Terminaison CAN de HBM (1­CONA1011)

Le câble d'interface � est branché à l'un des connec­
teurs CAN (de type LEMO) du MC1609 �. L'autre
extrémité du câble d'interface est branchée au sys­
tème d'acquisition de données eDAQ pour permettre
le fonctionnement et au connecteur Sub-D à 9
broches pour la programmation �.

Un PC standard est utilisé pour le logiciel SomatCR
Assistant � (reportez-vous au paragraphe  8.1
"Exigences système minimales requises").

Pour une communication CAN fiable, il est important
que le bus CAN soit muni d'une terminaison
CAN (1­CONA1011) �.
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2. Connectez-vous à l'appareil.

- Assurez-vous que l'alimentation électrique CAN soit
sous tension. La LED Power verte du MC1609 �
s'allume. Si ce n'est pas le cas, veuillez vérifier
votre installation. Si le problème persiste, référez-
vous au chapitre 11 "Dépannage".

- Démarrez le logiciel SomatCR Assistant de HBM
sur le PC �.

Consultez la documentation pour des informations
supplémentaires.

La documentation complète du logiciel (aide en ligne)
est installée en même temps que le logiciel et elle est
disponible dans le menu Démarrer de Windows au
niveau de Tous les programmes / HBM / SomatCR
Assistant / Doc

- Sélectionnez Options->Interface dans le menu
principal pour configurer l'interface CAN :
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- Démarrez la configuration automatique de tous les
appareils HBM raccordés en sélectionnant File
(Fichier)->Auto­Configuration (Configuration
auto.), puis en appuyant sur la combinaison de
touches Ctrl­A ou en cliquant sur l'icône
Auto­Configuration (Configuration auto.) 

dans la barre d'outils :
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Une nouvelle fenêtre de document affichant le
MC1609 16 raccordé (ayant le numéro de série
14136) apparaît.

- Ouvrez la boîte de dialogue Device (Appareil) en
double­cliquant sur la ligne présentant l'icône  :
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Cette boîte de dialogue affiche les paramètres de
l'appareil, tels que son "Serial number" (numéro de sé­
rie), "Device name" (nom d'appareil) ou "Rate" (la
vitesse). En complément, cette boîte de dialogue prévoit
des boutons permettant d'exécuter diverses actions à
l'aide de l'appareil, telles que la lecture ou l'écriture de la
configuration ainsi que l'ouverture d'une fenêtre d'affic­
hage des valeurs de mesure.
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► Affichez les valeurs de mesure actuelles de l'appareil,
en cliquant sur le bouton Measure (Mesure), dans la
boîte de dialogue Device (Appareil) :

- Pour les voies auxquelles aucun thermocouple n'a
été connecté, le système affiche "No Sensor" (Au­
cun capteur). Le cas échéant, branchez un thermo­
couple à certaines des voies pour en vérifier le bon
fonctionnement.
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- Le bouton Copy (Copier) permet de copier les va­
leurs de mesure dans le Presse-papiers. La case à
cocher to row (Sur une ligne) permet de définir si
vous voulez que le système copie toutes les don­
nées sur une ligne ou qu'il utilise une ligne par va­
leur de capteur.

3. Définissez les paramètres corrects pour CAN et
l'appareil.

- Sélectionnez d'abord les paramètres de bus CAN
utilisés au sein de votre installation. Dans la plupart
des cas, il s'agit de "500000 Bits/s" (500000 bps).
Double­cliquez sur l'icône du bus CAN  dans le
coin supérieur gauche de la fenêtre de document
ou sélectionnez Edit (Editer)->Edit (Editer) après
avoir sélectionné la ligne de bus CAN :
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Important

Faites attention lorsque vous modifiez les paramètres
CAN ! Dans la plupart des cas, la valeur par défaut
(500000 bps) n'a pas besoin d'être modifiée.

► Sélectionnez ensuite des identifiants CAN appro­
priés pour l'appareil.
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Important

Si vous avez l'intention de connecter l'appareil à un bus
existant comportant des périphériques tiers, assurez-
vous que les identifiants CAN soient uniques. Consultez
votre matrice CAN ou toute autre documentation !

► Pour finir, vous pouvez configurer les voies de
l'appareil (par exemple le nom de l'appareil ou
"Channel name"). Développez l'arborescence affichée
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et faites un double clic sur la ligne affichant la voie
concernée :
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4. Répétez les étapes 1. à 3. pour tous les appareils
à utiliser dans votre installation.

5. Installez vos appareils.

Reportez-vous au chapitre 7 "Installation" pour des
informations importantes sur l'alimentation électrique,
la topologie et autres !

Pour une configuration sur site connectez un PC, sur
lequel le logiciel SomatCR Assistant a été installé et
muni d'une CANcard, au bus CAN.

6. On distingue 3 manières différentes de préparer
les appareils en vue de l'installation :
I. Configuration automatique
II. Détection sur le bus et utilisation de la

configuration d'appareil
III. Application d'un fichier de configuration disponible

- Configuration automatique (File (Fic­
hier)->Auto­Configuration (Configuration auto­
matique) recherche tous les appareils SomatCR
Assistant connectés et les configure auto­
matiquement en évitant les conflits.

Sur site
(par ex. dans le
véhicule)
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En présence d'un conflit (identifiants identiques pour
plusieurs appareils), la configuration du ou des
appareils concernés est modifiée et la nouvelle
configuration est écrite sur l'appareil.

Important

A noter : la configuration automatique modifie la
configuration de l'appareil sans demande préalable de
confirmation.

- Pour exécuter un scan de bus, ouvrez un nouveau
document (File (Fichier)->New (Nouveau)) et dé­
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marrez le scan (File(Fichier)/Scan CAN­Bus
(Scanner le bus CAN)).

Des conflits risquent de se produire en fonction de la
configuration des appareils. Tous les appareils
concernés sont munis du symbole . Modifiez la
configuration au clavier (dans l'exemple ci-dessus : en
définissant et faisant passer l'identifiant CAN de
MC1609_14136 de 0x0180 à 0x0184) et en activant à
nouveau les appareils (Edit (Editer)->Activate (Acti­
ver)).

Si tous les conflits ont été éliminés, vous pouvez
reconfigurer tous les appareils (File (Fic­
hier)->Reconfigure All (Reconfigurer tout) ou ).
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- Une autre solution consiste à ouvrir un fichier de
configuration  (File (Fichier)/Open (Ouvrir)) pré­
paré. Vous contrôler ensuite que les appareils
installés et le fichier de configuration correspondent
bien (File (Fichier)/Check Document (Vérifier le
document)). Le système crée un rapport de cont­
rôle (Check Report) :
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- Le cas échéant, exécutez une reconfiguration en
sélectionnant File (Fichier)->Reconfigure All
(Reconfigurer tout). A titre d'alternative, vous
pouvez écrire la configuration d'un certain appareil
en ouvrant la boîte de dialogue de configuration de
l'appareil concerné et en cliquant sur le bouton
Write to device (Ecrire sur l'appareil).
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7. A présent, la configuration est terminée.

Il est recommandé de l'enregistrer dans un nouveau
fichier de configuration (File (Fichier)->Save as
(Enregistrer sous)) pour une utilisation ultérieure.

8. A présent, tous les appareils sur le bus CAN dev­
raient fonctionner parfaitement.

Vérifiez les LED des appareils MC1609 : la LED verte
doit être ACTIVE, la LED rouge doit être ETEINTE.

Si une LED rouge est ACTIVE sur un ou plusieurs
appareils, vérifiez à nouveau la configuration. Si des
appareils tiers ont été raccordés au bus CAN,
assurez-vous que tous les identifiants CAN utilisés
soient uniques pour chaque appareil !
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5 Connecteurs

Tous les connecteurs sont situés en face avant du
MC1609 :

� 16 connecteurs pour thermocouples

� 2 connecteurs LEMO pour CAN et l'alimentation
électrique (du côté droit)

Reportez-vous au paragraphe 9.1 "Voyants LED" pour
des informations concernant l'état des LED.

ATTENTION

Les types de connecteurs pour CAN et les thermo­
couples ont été sélectionnés étant donné qu'ils sont très
répandus sur le marché. La version standard du MC1609
est dotée de connecteurs à boîtiers hermétiques afin
d'assurer une protection IP6x de l'appareil.

Cependant, les contacts des connecteurs et des prises
(câbles des thermocouples) ne sont pas étanches à
100 %. HBM propose un pack de maintenance pour un
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entretien régulier (reportez-vous au paragraphe 2.7
"Maintenance & étalonnage").

Les types de connecteurs suivants sont disponibles :

5.1 Entrées pour thermocouples

L'appareil MC1609 prévoit 16 voies d'entrée pour cap­
teurs NiCr­Ni (de type K). Ces voies sont entièrement
isolées les unes par rapport aux autres ainsi que par rap­
port à l'interface CAN et l'alimentation électrique.

Le contact supérieur (près des voies numéro 1…16) est
un peu plus petit que les autres. Branchez le signal
"NiCr" sur ce contact. Le contact inférieur (près de
l'étiquette MC1609) est celui du signal "Ni".
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5.2 eDAQ (système d'acquisition de
données)

Le système eDAQ de HBM doit être connecté au
MC1609 à l'aide d'un câble spécial doté d'un connecteur
(mâle) LEMO CAN/d'alimentation électrique à une ext­
rémité et d'un connecteur (mâle) SoMat M8 de type pig­
tail de l'autre.

L'alimentation électrique du MC1609 est fournie par le
système eDAQ, ce qui fait qu'une alimentation externe
n'est pas nécessaire sur une chaîne simple. En présence
de plusieurs chaînes, il convient d'utiliser un autre câble
spécial. Reportez-vous au paragraphe 6 "Câbles" pour
des informations supplémentaires.

Connecteur femelle SoMat M8 / de type pigtail :
1­KAB421­2

Broche Signal Description

1 SWC NA

2 CAN_H CAN haut

3 AGnd Mise à la terre de l'alimentation
électrique, CAN

4 non connecté

5 Power + Pôle positif de l'alimentation
électrique

6 CAN_L CAN bas

Tab. 5.1 Affectation des broches

(vue en
face avant
du
module)1 2

3

4

5 6
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5.3 CAN / alimentation électrique

Le MC1609 utilise un connecteur mixte pour l'alimen­
tation électrique et CAN. 2 connecteurs (femelles) sont
disponibles pour les câbles de sortie et d'entrée. Ceci
permet un câblage aisé de plusieurs appareils MC1609 à
l'aide d'un câble fin seulement. Une telle chaîne doit être
munie d'une résistance de terminaison CAN au niveau du
dernier connecteur.

Divers câbles d'alimentation électrique et de chainage
d'appareils sont disponibles dans des longueurs dif­
férentes. Reportez-vous au paragraphe 6 "Câbles" pour
des informations supplémentaires.

Type LEMO : 1­KAB292­2

Broche Signal Description

1 Power + Pôle positif de l'alimentation
électrique

2 Power GND Mise à la terre de l'alimentation
électrique

3 CAN_H CAN haut

4 CAN_L CAN bas

5 CAN_GND Mise à la terre CAN

Châssis Blindage Blindage de câble

Note

Utilisez uniquement des câbles d'origine HBM pour les
connexions CAN (reportez-vous au paragraphe 6
"Câbles").

(vue en
face avant
du
module)

2

3 4

5

1
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Note

Le brochage des 2 connecteurs est identique. Les sig­
naux (bus CAN, alimentation) sont directement reliés
d'un connecteur à l'autre.
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6 Câbles

HBM propose toute une gamme de câbles optimisés
pour le MC1609.

Avantages des câbles MC1609 d'origine HBM :

� Câbles d'alimentation à faible déperdition

� Câbles CAN torsadés et blindés

� Câbles résistant à une température allant jusqu'à
+150°C

� Câbles testés à 100 % à l'issue de leur fabrication

Note

Il est fortement recommandé d'utiliser uniquement des
câbles d'origine HBM !

6.1 Connexion entre 2 appareils

6.1.1 Câble de liaison MC1609 (1-KAB291-2/5/10)

ÓÓÓ
ÓÓÓ
ÓÓÓ

ÓÓÓÓ
ÓÓÓÓ
ÓÓÓÓ

1-KAB291-2

(mâle) (mâle)

Utilisation : liaison (alimentation, CAN) d'appareils MC1609 en
chaîne

Longueur : diverses longueurs de câbles sont disponibles (2 m, 5 m,
10 m)



Câbles

44 A3686-1.1  HBM: public SomatCR

Connexion : du connecteur CAN d'un appareil à l'autre ou reportez-
vous au paragraphe 6.1.2
"Prolongateur de câble MC1609" pour des informations
sur le couplage de 2 câbles de liaison. Veuillez noter qu'il
est préférable d'utiliser un câble ayant la longueur
correcte plutôt que de coupler plusieurs câbles.

Référence Description

1-KAB291-2 Câble réseau SomatCR (2 m)

1-KAB291-5 Câble réseau SomatCR (5 m)

1-KAB291-10 Câble réseau SomatCR (10 m)

1-KAB292-2 Câble eDAQ SomatCR/CR (2,5 m)

1-KAB421-2 Câble d'alimentation SomatCR/CR (2,5 m)

1-CONA1011 Terminaison

6.1.2 Prolongateur de câble MC1609

Disponible sur demande

ÓÓÓÓ
ÓÓÓÓ
ÓÓÓÓ

ÓÓÓÓ
ÓÓÓÓ
ÓÓÓÓ

DEMANDE

(femelle) (femelle)

Utilisation : couplage de 2 câbles de liaison, afin d'obtenir une lon­
gueur de câble plus importante

Connexion : entre 2 câbles de liaison MC1609
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6.1.3 Câble de liaison MC1609 avec alimentation
électrique (1­KAB423­2)

ÔÔÔ
ÔÔÔ

ÔÔÔ
ÔÔÔ

CAN & alimentation électrique

150 cm 100 cm

Uniquement CAN

(mâle)

300 cm

(mâle)

1-KAB423-2

Utilisation : alimentation électrique de tous les appareils enchaînés
et liaison (alimentation, CAN) entre 2 appareils MC1609
de cette même chaîne

Longueur : câble d'alimentation électrique 3,0 m
câble de liaison entre appareils 2,5 m

Connexion : fiche banane rouge pour le pôle positif (PLUS) de l'ali­
mentation électrique, fiche banane noire pour le pôle
négatif (MOINS) de l'alimentation électrique.
Reportez-vous au paragraphe  10.1 "Alimentation" pour
des informations supplémentaires sur la plage de tension
autorisée !

Connecteurs LEMO : ils permettent de brancher le
connecteur CAN de l'un des appareils au connecteur
CAN d'un autre appareil.

L'alimentation est branchée au connecteur (mâle) LEMO
gauche uniquement (CAN & ALIMENTATION sont re­
pérés par l'étiquette). Le connecteur (mâle) LEMO de
droite est destiné uniquement aux signaux CAN.



Câbles

46 A3686-1.1  HBM: public SomatCR

Note

Assurez-vous de ne brancher qu'UN CONNECTEUR
AVEC ALIMENTATION à un appareil. (Seul un branc­
hement doit être réalisé sur un connecteur muni d'une
telle étiquette).

Référence Description

1-KAB423-2 Interruption d'alimentation entre SomatCR et
l'eDAQ

Câble en option d'alimentation du MC1609 à partir d'un
équipement externe et connecteur Turck pour le module
CAN de l'eDAQ :

ÔÔ
ÔÔ

ÔÔÔ
ÔÔÔ

CAN & alimentation électrique

150 cm 100 cm

Uniquement CAN

(femelle)

300 cm

(mâle)

1-KAB421-2

Référence Description

1-KAB421-2 Interruption d'alimentation entre SomatCR et
le module CAN de l'eDAQ
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6.2 Connexion au système CAN

6.2.1 Câble d'interface MC1609 avec alimentation
électrique (1­KAB292­2)

ÔÔÔ
ÔÔÔ

ÔÔ
ÔÔ

ÔÔ
ÔÔ
ÔÔ
ÔÔ

250 cm

1-KAB292-2

Utilisation : connexion de l'alimentation électrique du premier
MC1609 d'une chaîne d'appareils, connexion du bus
CAN au système eDAQ par le biais du connecteur Somat
M8 de l'interface eCom.

Longueur : longueur de câble disponible :
1­KAB292­2 2,5 m

Connexion : connecteur SoMat M8 ayant le brochage suivant : 
broche 1 : SWC, broche 2 : CAN_H, broche 3 : AGnd,
broche 5 : alimentation et broche 6 : CAN_L reportez-
vous paragraphe 5.2
"eDAQ (système d'acquisition de données)")

Connecteur LEMO du premier MC1609 de la chaîne
d'appareils

Référence Description

1-KAB292-2 Alimentation CAN du MC1609 par l'eDAQ,
2,0 m avec M8 et LEMO



Câbles

48 A3686-1.1  HBM: public SomatCR

6.2.2 Terminaison CAN (1-CONA1011)

ÖÖÖÖ
ÖÖÖÖ

Utilisation : terminaison de bus CAN en fin de chaîne d'appareils

Connexion : terminaison enfichée dans le connecteur restant du
dernier MC1609 de la chaîne

Référence Description

1-CONA1011 Terminaison CAN de MC1609
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7 Installation

7.1 Conseils en matière d'alimentation
électrique

Les MC1609 de HBM sont des appareils à faible
consommation ne dépassant pas 2 watts (typ.). Les
câbles d'origine HBM (très faible déperdition de cou­
rant sur les câbles) et la taille compacte des
appareils permettent une installation AISÉE et SANS
PROBLÈME dans la plupart des cas.

Les paramètres suivants sont importants lors du choix de
la stratégie à suivre en matière d'alimentation électrique :

� Tension électrique minimale
Il s'agit de la valeur de tension minimale fournie par
l'alimentation électrique. Dans les applications auto­
mobiles, il s'agit normalement de celle du système
d'alimentation embarqué (par ex. "12 V" pour les
voitures particulières). Notez que la valeur minimale
est importante. Dans un système "12 V", cette valeur
peut descendre jusqu'à 8 V (pendant plusieurs milli­
secondes) lors de l'actionnement du démarreur.

� Nombre de MC1609
Tout appareil nécessite une alimentation électrique
pour pouvoir fonctionner (2 W typ., reportez-vous à la
fiche technique disponible au paragraphe 10.1
"Alimentation"). À la mise sous tension, un appel de
courant temporaire enregistré risque d'être supérieur
au courant moyen de fonctionnement. L'alimentation
électrique doit être capable de fournir assez de cou­
rant pour tous les appareils raccordés.
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� Longueur de câble
La résistance des câbles de liaison entraîne une perte
de tension le long du câble dépendant de la longueur
de ce dernier et du courant le traversant. La tension
sur le dernier appareil d'une chaîne alimentée doit
être comprise dans les limites spécifiées (8 V ou plus,
reportez-vous à la fiche technique disponible au
paragraphe 10.1 "Alimentation").

Pour les applications typiques, HBM recommande
l'installation suivante :

� tension d'alimentation  12 V, longueur de câble totale
 10 m :
7 appareils au maximum par alimentation électrique

� tension d'alimentation  8 V, longueur de câble totale
 10 m :
5 appareils au maximum par alimentation électrique
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7.2 Chaînage simple

CAN 00000

eDAQ

CAN 00000

CAN 00000

CAN 00000

1-CONA1011

1-KAB291-2/5/10

1-KAB291-2/5/10

1-KAB291-2/5/10

1-KAB292-2
1-KAB421-2 avec
alimentation

PC muni d'une CANcard
et du logiciel SomatCR
Assistant

� Le système d'acquisition de données (eDAQ) est rac­
cordé au premier appareil MC1609 par le câble de
communication CAN intégrant une alimentation
électrique (1­KAB292­2). Le câble 1­KAB421­2 peut
être utilisé lorsqu'une alimentation externe est
requise, tel qu'en présence d'un module CAN intelli­
gent.

� En fin de bus CAN, une terminaison CAN
(1­CONA10111) est branchée au connecteur CAN
restant.

� Le système eDAQ constitue le début de la chaîne
d'appareils. On distingue certaines restrictions en
fonction du nombre d'appareils, de la longueur de
câble et de la tension minimum.
Reportez-vous au paragraphe 7.1
"Conseils en matière d'alimentation électrique" pour
des informations supplémentaires.
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7.3 Chaînage long comportant une
alimentation externe supplémentaire

CAN 00000

eDAQ

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

CAN 00000

1-KAB291-2/5/10

1-KAB292-2 PC muni d'une CANcard et du
logiciel SomatCR Assistant

1-KAB423-2

1-KAB291-2/5/10

1-KAB423-2

1-KAB291-2/5/10

1-CONA1011

1-KAB423-2

ALIMEN‐
TATION 2

ALIMEN‐
TATION 1
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� Le présent exemple illustre une installation plus com­
plexe comportant 3 clusters de plusieurs appareils
MC1609 chacun.

� Tous les appareils sont reliés à un bus CAN. En fin de
bus CAN, une terminaison CAN (1­CONA1011) est
branchée au connecteur CAN restant.

� Chaque cluster possède sa propre alimentation afin
de réduire à un minimum les déperditions de courant
le long des câbles de liaison.

� Lorsqu'il est utilisé sur des appareils autres que le
système eDAQ de HBM, le premier appareil doit être
raccordé à une source d'alimentation adéquate. Cela
peut être réalisé au moyen de l'un des câbles
MC1609 suivants : 1­KAB292­2 (M8 vers MC1609),
1­KAB422­2 (Sub­D 9 broches vers MC1609 ) ou
1­KAB296­2  (‘pigtail’ ouvert vers MC1609).

� Un  câble de liaison MC1609 intégrant une alimen­
tation électrique (étiquette) est installé entre le
premier et le second clusters Ce câble transmet direc­
tement les signaux du bus CAN entre les appareils.
L'alimentation électrique passe uniquement du
premier au second cluster. Aucune alimentation
électrique ne passe entre les deux connecteurs
LEMO.
Les 2 câbles à connecteurs bananes sont branchés
au connecteur LEMO muni de l'étiquette blanche.

Note

Assurez-vous d'installer correctement le câble de liaison
MC1609 intégrant une alimentation électrique (étiquette),
en branchant le connecteur LEMO marqué à l'un des
connecteurs CAN du premier appareil du second cluster.



Installation

54 A3686-1.1  HBM: public SomatCR

� Tout comme le second cluster, le dernier cluster est
doté de sa propre alimentation électrique grâce à un
câble de liaison MC1609 à alimentation intégrée
(étiquette).

Reportez vous au paragraphe 7.1
"Conseils en matière d'alimentation électrique" ci-dessus
pour des informations supplémentaires sur le choix d'une
stratégie d'alimentation électrique adéquate.
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8 Configuration

Le MC1609 peut être configuré de manière à utiliser des
paramètres de transmission CAN personnalisés.

L'ensemble de la configuration est réalisé par le biais de
l'interface CAN du MC1609. Un protocole de
configuration CAN puissant utilisé permet de fournir la
configuration adéquate du MC1609.

La configuration est exécutée à l'aide de l'application
Windows SomatCR Assistant, (SomatCR­Assistant.EXE)
fournie sur CD avec tous les appareils.
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Reportez-vous à l'aide en ligne de cette application pour
des informations supplémentaires sur la configuration.
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Remarques importantes concernant la configuration

Note

L'utilisation du débit CAN correct est nécessaire pendant
la configuration, notamment en présence d'appareils tiers
reliés au bus CAN.

Note

Si des problèmes surviennent pendant la configuration,
déconnectez tous les appareils tiers. Si les problèmes
persistent, veuillez contacter le support technique de
HBM (reportez-vous au paragraphe 2.9
"Mises à jour & contact").

8.1 Exigences système minimales
requises

PC standard sous un système d'exploitation Windows de
Microsoft
Recommandé : AMD Athlon/Pentium IV ou supérieur,
Windows XP, Vista et 7 (Vista/7 doit être installé en
mode Administrateur)

L'un des équipements/pilotes CAN tiers doit avoir été
installé sur le système :

Vector CAN (www.vector­informatik.de) 1

API : XL driver library 7.4

1) Equipements ayant été testés : CANCard Vector

Plate-forme

Interface CAN
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vxlapi.dll  7.4.50.0
vcanxl.sys / vcasexl.sys  7.3.18

Kvaser CAN (www.kvaser.se) 2

API : CANLIB 4.0

canlib32.dll 6.09.4495
kcane.sys 6.09.4495

dSpace Generic CAN (www.dspace.de) 3

Adaptateur DCI­CAN1 uniquement

CanApi2.dll 2.47.1
DSCanApi10.dll 2.3.0.45
PCAN_USB.SYS 2.48.14.0

PEAK (www.peak­system.com) 4

Adaptateur PCAN­USB uniquement

Pcan_usb.dll 1.54.0
PCAN_USB_SYS 2.49.8.4514

Softing (www.softing.com) 5

API CAN Layer2 (V5.11)

canL2.dll 5.11.0.1
canusbw.sys 6.0.2.63

National Instruments (www.ni.com) 6

API : NI­CAN 2.5.2

2) Equipement ayant été testé : Kvaser USBcan2
3) utilise le pilote PCAN et la DLL d'API dSPACE installée

conjointement au dSPACE CalDesk
Equipement ayant été testé : dSpaceCallDesk 2.0

4) PEAK : l'API PEAK Lite est prise en charge à l'heure actuelle. PEAK
CANAPI2 n'est pas encore gérée
Equipement ayant été testé : PCAN­USB avec API PCAN Light

5) Equipement ayant été testé : Softing CANusb
6) Equipement ayant été testé : NI PCMCIA­CAN Series 2
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nican.dll 2.5.0.49158
nicanpkw.sys 2.5.1f0

IXXAT (www.ixxat.com) 7

API : NI­CAN 2.5.2

vcinpl.dll 1.0.0.1784
vci109w3.sys 3.1.4.1784

Le support d'autres équipements CAN est disponible sur
demande.

8.2 Conseils d'utilisation

Le paramétrage par défaut en sortie d'usine pour le
MC1609 est le suivant (protocole CANopen) :
Débit CAN 500 000 bps
Point d'échantillonnage 66 %
Longueur d'identifiant 11 bits (CAN standard)
ID de nœud 1
Identifiant CAN 0x0180 + NODE_ID, 

0x0280 + 
NODE_ID,
0x0380 + NODE_ID et 
0x0480 +
NODE_ID

Format de données INTEL
Résolution 0,1 °C
Débit 100 ms

Il est fortement recommandé d'exécuter la configuration
de base (débit CAN, identifiants ...) séparément pour
chaque appareil (reportez-vous au paragraphe 4,
notamment 4.1 "Au bureau ou en laboratoire").

7) Equipement ayant été testé : IXXAT USB­-­CAN compact
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9 Fonctionnement

9.1 Voyants LED

En face avant du MC1609, une LED (Light Emitting
Diode ou diode électroluminescente) près des connec­
teurs CAN indique l'état de fonctionnement (reportez-
vous aux Spécifications de voyants CANopen DR­303­3).

Cette LED peut indiquer l'un des états suivants :

HORS TENSION La LED est éteinte

SOUS TENSION La LED est allumée

DOUBLE FLASH La LED s'allume 2 fois (200 ms), la
seconde phase éteinte dure 1000 ms

SIMPLE FLASH La LED est allumée pendant 200 ms et
éteinte pendant 1000 ms

CLIGNOTEMENT
RAPIDE

La LED clignote (allumée pendant
200 ms, éteinte pendant 200 ms, etc.)

CLIGNOTEMENT La LED clignote (allumée pendant
1 seconde, éteinte pendant 1 seconde,
etc.)

En mode de fonctionnement normal (par ex. après la
mise sous tension), la LED verte "Power" est allumée et
la LED rouge "Error" est éteinte.

Les modules disposent également d'un voyant par voie.
Reportez-vous au paragraphe 9.1.2
"Affichage des LED des voies" pour des informations
supplémentaires.



Fonctionnement

SomatCR A3686-1.1  HBM: public 61

9.1.1 Description

HORS TENSION Aucune alimentation électrique apposée

SOUS TENSION
(vert)

L'appareil est OPERATIONNEL

FLASH SIMPLE
(vert)

L'appareil est en état d'arrêt

CLIGNOTEMENT
RAPIDE (vert)

L'appareil est en étant PRE-OPE­
RATIONNEL

HORS TENSION
(rouge)

L'appareil en état de fonctionnement

SOUS TENSION
(rouge)

L'état de bus de l'appareil est
"désactivé" (la désactivation du bus est
gérée par le contrôleur CAN)

DOUBLE FLASH
(rouge)

Un événement "Guard" ou "Heartbeat"
s'est produit

CLIGNOTEMENT
(vert/rouge)

Téléchargement du firmware en cours

9.1.2 Affichage des LED des voies

HORS TENSION Un thermocouple a été connecté

SOUS TENSION
(rouge)

Aucun thermocouple n'a été connecté
(rupture de capteur)
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9.2 Communication CAN

En mode de fonctionnement normal (reportez-vous au
paragraphe 9.1 "Voyants LED"), le MC1609 transmet
régulièrement des messages CAN contenant les
températures mesurées.

Les paramètres du bus CAN (par ex. le débit) ainsi que
les messages CAN (par ex. l'identifiant, le taux de
transfert) peuvent être configurés. Reportez-vous au
paragraphe  8 "Configuration" pour des informations
supplémentaires.

9.2.1 Messages

ID Rate DLC
DATA

0
DATA

1
DATA

2
DATA

3
DATA

4
DATA

5
DATA

6
DATA

7

0x0181 rate 8
CH1 CH2 CH3 CH4

0x0182 rate 8
CH5 CH6 CH7 CH8

0x0183 rate 8
CH9 CH10 CH11 CH12

0x0184 rate 8
CH13 CH14 CH15 CH16

L'identifiant CAN (ID) du premier message CAN peut être
configuré avec le logiciel SomatCR Assistant (reportez-
vous au paragraphe 8 "Configuration").

La fréquence (rate) des messages CAN contenant les
données de la voie 1 à 16 (CH1…CH16) peut être
configuré (5 ms, 10 ms, 20 ms, 50 ms, 100 ms, 200 ms,
500 ms, 1000 ms, 2000 ms ou 5000 ms).
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Reportez-vous au paragraphe 9.2.2 "Signaux" pour une
description des octets DATAx des messages.

9.2.2 Signaux

CH1 … CH16

Description : valeur de température d'entrée de thermocouple

Résolution: 0,1 °C

Plage : ­100,0 °C … +1372,0 °C ou 0xFC18 … 0x3598 respecti­
vement

Rupture de capteur : valeur spéciale si aucun thermocouple n'a été détecté au
niveau de l'entrée 0x8000

Format : INTEL (LSB first)
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10 Fiche technique

Tout comme pour de nombreux appareils électroniques,
l'exactitude de mesure du MC1609 dépend de l'instal­
lation et des conditions d'utilisation de l'appareil.

Si, par exemple, l'appareil est utilisé dans des conditions
ambiantes comprises entre ~ ­10°C et ~ +50°C avec des
mesures jusqu'à 1100°C, la précision est alors ≤ 0,5°C.
En revanche, si la température ambiante est inférieure à
­30°C ou supérieure à +85°C, ce niveau d'exactitude
descendra à environ ≤ 0,5°C par 15°C (dans chaque
direction) au fur et à mesure que les valeurs augmentent
au-dessus de 1150°C .

Important

Les valeurs d'exactitude indiquées ci-dessus se basent
sur l'utilisation de câbles ≤ 3 m (voir paragraphe 2.4).

10.1 Alimentation

Plage de tension d'env. 8 V à 42 V C.C.

Puissance absorbée 2,0 W typ. (16 voies)

Connecteurs LEMO (de type 0B) pour les câbles HBM (reportez-vous au
paragraphe 6 "Câbles")

Fusible de sécurité Il est conseillé d'utiliser un fusible de sécurité externe en cas
d'alimentation non protégée par fusibles. Le fusible doit cou­
per le courant après 120 s max. à 4,76 A. Il est possible d'utili­
ser par exemple un fusible ATO standard de "2A".
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10.2 Entrées

Voies 16 voies d'entrée

Capteur Thermocouples NiCr­Ni (de type K)
Thermocouples Fe-CuNi (de type J)
Thermocouples Cu-CuNi (de type T)

Connecteurs Thermoconnecteurs miniatures

Plage de mesure Type K: ­100 °C à +1372 °C
Type J: -100 °C à +1200 °C
Type T: -100 °C à +400 °C

Résolution de mesure 16 bits

Unité de mesure 0,1 °C

Exactitude de mesure Reportez-vous au tableau (à la fin de ce paragraphe). Pour
toute information complémentaire, veuillez contacter votre
support HBM local.

Vitesse
d'échantillonnage
interne

1 000 Hz

Vitesse de mesure 1/5 Hz, 1/2 Hz, 1 Hz, 2 Hz, 5 Hz, 10 Hz, 20 Hz, 50 Hz, 100 Hz,
200 Hz

Filtre d'entrée Filtre passe­bas avec filtrage numérique

Fonctions Détection de connexion capteur interrompue,
connexion de référence séparée pour chaque voie

Protection d'entrée ±60 V continue, protection ESD

Tension d'isolement 500 V C.C, entre les voies d'entrée
500 V C.C, entre voie d'entrée et alimentation électrique
500 V C.C, entre voie d'entrée et CAN
500 V C.C, entre alimentation électrique et CAN
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10.3 Interface CAN

Spécifications CAN CANopen (EN 50325­4)

Couche physique CAN grande vitesse (ISO 11898)

Débit 125 kbps, 250 kbps, 500 kbps (par défaut), 1 Mbps

Connecteurs LEMO (de type 0B) pour les câbles HBM (reportez-vous au
paragraphe 6 "Câbles")

10.4 Configuration

Interface Via bus CAN

Protocole Compatible avec tous les autres équipements MC1609

Enregistrement Mémoire non volatile interne

Utilisation Application Windows SomatCR Assistant
(SomatCR­Assistant.EXE)

10.5 Dimensions

Taille (l x H x P) Env. 200 x 35 x 50 mm³ (77/8" x 13/8" x 2")

Poids Env. 500 g (env. 173/5 oz.)
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10.6 Montage

Trous de fixation

Taille des vis : M4 x 10 mm

X

YTrou d'aération

Vue arrière

X = 194 mm Y = 29 mm

ATTENTION

Ne pas couvrir le trou d'aération ! Ne rien introduire dans
ce trou ! Reportez-vous aux paragraphes 2.5, 2.6, 2.9 !!

Contactez HBM pour des plans détaillés.
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10.7 Conditions ambiantes

Version standard

Température de
fonctionnement

­40 °C à +120 °C 
(env. ­40 °F à +250 °F)

Humidité 5 % à 95 % (sans condensation)

Altitude 0 m à 2000 m

Protection IP65

Degré de pollution 3 (selon IEC 60664-1)
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11 Dépannage

Pour commencer, lisez les intitulés en caractères gras 
des rubriques ci-dessous. Il se peut que la solution à
votre problème soit facilement trouvée.

La LED "Power" reste éteinte en permanence

Assurez-vous que la tension d'alimentation soit comprise
dans la plage indiquée (reportez-vous au parag­
raphe 10.1 "Alimentation").

Utilisez un câble d'alimentation approprié 
(reportez-vous au paragraphe 6 "Câbles").

Une panne matérielle d'un appareil peut constituer une
autre cause. Contactez HBM (reportez-vous au parag­
raphe 2.9 "Mises à jour & contact").

J'ai besoin d'aide de la part de HBM

Si vous avez besoin d'aide, utilisez notre formulaire de
support disponible dans l'Internet (rreportez-vous au
paragraphe 2.9 "Mises à jour & contact").
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